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Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
if you are hearing impaired.
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To provide feedback on this documentation, send email to epmdoc_ww@oracle.com
or, in an Oracle Help Center topic, click the Feedback button located beneath the
Table of Contents (you may need to scroll down to see the button).

Follow EPM Information Development on these social media sites:

LinkedIn - http://www.linkedin.com/groups?gid=3127051&goback=.gmp_3127051
Twitter - http://twitter.com/hyperionepminfo

Facebook - http://www.facebook.com/pages/Hyperion-EPM-Info/102682103112642

Google+ - https://plus.google.com/106915048672979407731/
#106915048672979407731/posts

YouTube - https://www.youtube.com/oracleepminthecloud
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Welcome to Smart View Installation and

Configuration
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This help includes topics on these subjects:

To find information in this help, click Contents or Search in the left frame.

Installing Oracle Smart View for Office
Administering extensions

Configuring shared connections in an XML file
Configuring locally-installed help
Troubleshooting tips

Limitations
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Installing Smart View

Related Topics

*  About Installing Smart View

* Installation Guidelines

» Installing from My Oracle Support or Oracle Technology Network
* Installing Browser Add-ons

* Installing by Autodeployment in EPM System

* Installing from EPM Workspace

* Installing from Oracle Bl EE

*  Running Command Line or Silent Installations

* Downloading Help for Local or Web Server Installation

e Uninstalling Smart View

About Installing Smart View

Oracle Smart View for Office uses a single installer for 64-bit and 32-bit versions of
Microsoft Office, starting with release 11.1.2.5.

Late-breaking information about the Smart View installation is provided in the Oracle
Smart View for Office Readme. You should thoroughly review this chapter along with
the information in the readme before installing Smart View.

Late-breaking information about installing client products in Oracle Enterprise
Performance Management Cloud environments is provided in the What's New
document for each service. Review this information thoroughly before installing client
products.

Late-breaking information about the installation of Oracle Enterprise Performance
Management System products is provided in the Oracle Enterprise Performance
Management System Installation and Configuration Readme. Review this information
thoroughly before installing EPM System products.

Installation Guidelines

ORACLE

Related Topics

» Installation and Windows Access Control Settings
» Installer Language

*  Microsoft .NET Framework Support

*  BiDi Support in Installer

e Upgrading from Smart View 11.1.1.3.x or Earlier
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Chapter 2
Installation Guidelines

» Oracle Bl EE Extension Users: Upgrading from Smart View 11.1.2.5.500 or Earlier

*  Oracle Bl EE Version Requirement for Multiple Connection and View Designer
Features

*  Planning Offline Support

Installation and Windows Access Control Settings

Starting with the 11.1.2.5.400 release, you can install Oracle Smart View for Office as
a System user or as a non-admin user.

Windows User Access Control (UAC) settings can affect Smart View installation. For
information on setting UAC, see the Microsoft Windows documentation.

Also, see Tips and Troubleshooting if you encounter issues related to installation.

Table 2-1 Installation Guidelines for System, Admin, and Non-Admin Users

System user

Administrator

Non-admin user

Installation Context Scenario UAC-Enabled Result
Smart Vi ew. exe is launched Not applicable Smart View is installed on
by the Windows scheduler the machine level
or PsExec
The user runs Depending on the UAC Smart View is installed on
Smart Vi ew. exe with the level, the user may need to the machine level
"Run as Administrator" go through the UAC UlI
command or from an sequence
elevated command prompt
The user installing Smart ~ No UAC interaction is Smart View is installed on
View may or may notbe a expected. the current user's level;
member of the other users will not be able
Administrators group. to run Smart View

Note: Not supported on
Windows server platforms.

ORACLE

Notes:

e This scenario is not supported: A user installs Smart View, and then, on the same
machine, another user tries to install Smart View in the same location as the
previous installation.

e After non-admin installations:

— Launching Office applications with Smart View content from Internet Explorer
will fail in protected mode.

See Web Launch with Internet Explorer in Protected Mode to add trusted sites
when Internet Explorer is run in protected mode.

— The Smart View ribbon may fail to appear on Windows 10.

See Smart View Ribbon Fails to Display After Non-Admin Installation on
Windows 10 for steps to take to display the ribbon.

» Upgrade in mixed installation context is not supported. For example, upgrading the
previously-installed per-machine installation with a per-user one is not supported
(Error 1925).
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Chapter 2
Installation Guidelines

» Silent installations are not supported for non-admin users. When attempting a
silent installation, the / s flag is ignored for non-admin users, causing the Smart
View product installer to launch.

e Non-admin users are not authorized to install Smart View in the C:\ Program Fi | es
or C:\Program Files (x86) folders.

Installer Language

The installer is automatically displayed in the language set in the Format field of the
Windows Region and Language dialog box in the Control Panel.

However, some messages, both on-screen and in the log file, cannot be translated
and will appear in English.

For more information about language settings, see Windows, Office, and Smart View
Locale Settings.

Microsoft NET Framework Support

To install and use Oracle Smart View for Office release 11.1.2.5.600+, Microsoft .NET
Framework 4.5 or higher is required.

BiDi Support in Installer

The Oracle Smart View for Office installer does not fully support bidirectional (BiDi)
languages. This can result in installer screens containing formatting errors such as
misaligned text and icons. The installer can be used, however, and the installed Smart
View product will display correctly in BiDi languages.

Upgrading from Smart View 11.1.1.3.x or Earlier

When upgrading from Oracle Smart View for Office release 11.1.1.3.x or earlier,
Oracle recommends uninstalling Smart View before installing this release.

Oracle Bl EE Extension Users: Upgrading from Smart View
11.1.2.5.500 or Earlier

ORACLE

If you're using the Oracle Bl EE extension, and upgrading from Oracle Smart View for
Office 11.1.2.5.500 or earlier to Smart View 11.1.2.5.510 or later, a complete uninstall
of Smart View is required:

1. Close all Office applications.
2. Uninstall Smart View from the Windows Control Panel.
3. Install Smart View.

See Installing from My Oracle Support or Oracle Technology Network.
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Chapter 2
Installing from My Oracle Support or Oracle Technology Network

Oracle BI EE Version Requirement for Multiple Connection and View
Designer Features

To use the multiple connection and View Designer features described below, ensure
that the Oracle Business Intelligence Enterprise Edition 11.1.1.7.140527 patch or
higher is installed. Go to My Oracle Support, Patches & Updates tab, and search by
"Product or Family." In the Product field, select Oracle Business Intelligence
Enterprise Edition; in the Release field, select OBI EE 11.1.1.7.140527.

*  Multiple connections are supported with Oracle Bl EE version 11.1.1.7.140527 and
higher. If connecting to earlier versions of Oracle Bl EE, then only one connection
is allowed.

* To use the Oracle Bl EE View Designer feature (introduced in the 11.1.2.5.200
release), the Oracle Bl EE 11.1.1.7.140527 patch or higher is required.

You should only use the View Designer in Oracle Smart View for Office to edit
views that were created and inserted using the View Designer.

See "Editing Views Created in View Designer" in the Oracle Smart View for Office
User's Guide for more information.

Planning Offline Support

Although Planning Offline is supported for 64-bit operating systems, it is not supported
for 64-bit Oracle Smart View for Office installations. If you use Planning Offline with
Smart View, you must install the 32-bit version of Microsoft Office.

# Note:

Planning Offline is supported with Oracle Hyperion Planning on-premises
only. Planning Offline is not supported with Oracle Planning and Budgeting
Cloud.

Installing from My Oracle Support or Oracle Technology

Network

ORACLE

To install Oracle Smart View for Office directly from My Oracle Support (MOS) or
Oracle Technology Network (OTN):

1. Before you begin:

» If you are upgrading to this release from an earlier Smart View release, Oracle
recommends that you first uninstall the earlier release before installing this
release.

»  Ensure that Microsoft .NET Framework 4.5 or higher is installed on the
computer where you are installing Smart View.

Microsoft .NET Framework 4.5 or higher is required to install and use Smart
View.

2-4



ORACLE

Chapter 2
Installing from My Oracle Support or Oracle Technology Network

* Review the information in Installation Guidelines.
Close all Microsoft Office applications.

Download the Smart View zip file from either MOS or OTN:
*  From MOS:

https://support.oracle.com/oip/faces/secure/km/DocumentDisplay.jspx?
id=1923582.1

This Knowledge Article provides a link to the current version of Smart View.
*  From OTN:

http://www.oracle.com/technetwork/middleware/smart-view-for-office/overview/
index.html

Before downloading, review the "OTN License Agreement" accessed from the
Smart View download page to ensure that your usage is compliant.

Unzip the file to a temporary location.

Double-click Smart Vi ew. exe to start the installation wizard.

Select a destination folder for Smart View, and then click OK.

For new installations, Smart View is installed by default in:

C\Oraclel Smart Vi ew

If you are upgrading an existing installation of Smart View, the installer defaults to
the folder where Smart View was previously installed.

When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.

# Note:

Starting with Smart View 11.1.2.5.510, the Oracle Bl EE per-user
extension installer is included with the Smart View client installation. If
the extension is not already installed and it is not disabled, then it is
installed the first time you start Office.

If your default browser is Mozilla Firefox or Google Chrome, a browser add-on is
required. See Installing Browser Add-ons for more information.

# Note:

If you encounter issues related to installation and startup, see Tips and
Troubleshooting.
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Chapter 2
Installing Browser Add-ons

Installing Browser Add-ons

ORACLE

You can use Oracle Smart View for Office to interact with web browser applications,
such as Oracle Financial Consolidation and Close Cloud or Oracle Hyperion Planning,
in two ways:

e Starting in a form or ad hoc grid in Smart View, use drill-through to launch an
application web page in a browser

e Starting in a web application, launch a form or ad hoc grid in Smart View for Excel.

If your default browser is Microsoft Internet Explorer, drill-through and web launch are
fully supported and require no additional add-on.

If your default browser is Mozilla Firefox or Google Chrome, you'll require a Smart
View add-on for drill-through and web launch.

Table 1 summarizes the browser add-on requirements.

Table 2-2 Browser Add-on Requirements for Drill-Through and Web Launch

Browser Add-on Required?
Microsoft Internet Explorer No

Mozilla Firefox Yes

Google Chrome Yes

For instructions on obtaining and installing the add-on for Firefox and Chrome, see:

e Mozilla Firefox

e Google Chrome

Mozilla Firefox

To use Smart View 11.1.2.5.810 with Mozilla Firefox ESR 60 and later, you must
install the Oracle Smart View for Office web extension for Firefox.

You can get the extension by searching on "smartview" on the Firefox Add-ons
download site or by going directly to this link:

https://addons.mozilla.org/en-US/firefox/addon/oracle-smart-view-for-office

Click the + Add to Firefox button and follow the prompts to add the extension.

# Note:

If you are using earlier versions of Firefox, then no add-on is required.

Google Chrome

Oracle Planning and Budgeting Cloud 17.06+ and Oracle Enterprise Planning and
Budgeting Cloud 17.06+ support interoperability with Google Chrome and Smart View
11.1.2.5.700+.
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Installing by Autodeployment in EPM System

To use Google Chrome with Smart View, install the Oracle Smart View for Office web
extension from the Chrome Web Store. You can get the extension by searching on
"smartview" in the Chrome Web Store or by going directly to this link:

https://chrome.google.com/webstore/detail/oracle-smart-view-for-off/
cjbpfomjjhkmfkembnjejkhpihjnomne

Click the + Add to Chrome button and follow the prompts to add the extension.

Installing by Autodeployment in EPM System

These instructions are for upgrading from Oracle Smart View for Office 11.1.2.1.x and
later only. If you are upgrading from Smart View 11.1.2.0.x or earlier, use the
autodeployment instructions provided in the documentation for the specific release.

Server Setup

To set up the server environment for autodeployment of Oracle Smart View for Office:

1. Enable autodeployment for your data provider as follows.
* Oracle Essbhase: Choose a method:
— Use Administration Services Console (if available).

a. Connect to the Provider Server, select Edit, then Properties, then
Client Deployment.

b. Choose either Force Smart View client to upgrade or Warn Smart
View client to upgrade.

c. Select the Apply Smart View client to upgrade check box, and then
click Apply.

— Update essbase. properties as follows:
a. Navigate to EPM ORACLE_| NSTANCE\ bi n\ essbase. properti es.
b. Set either or both of these properties to true:

shartvi ew. webservi ce. aut odepl oy. force=t rue
smartvi ew. webser vi ce. aut odepl oy. war n=t r ue

e Oracle Hyperion Planning:

a. Select Administration, then Manage Properties, and then System
Properties.

b. Setthese properties:

SMART VI EW FORCE_| NSTALL=t r ue
SMART VI EW DI SPLAY_WWARNI NG=t r ue

*  Oracle Hyperion Financial Management: Autodeployment is enabled by
default starting in Financial Management 11.1.2.4. To configure Financial
Management to turn off messages about upgrading Smart View, complete the
procedure in Oracle Support Document 1993603.1 on My Oracle Support:

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1993603.1

* Oracle Hyperion Reporting and Analysis: Autodeployment is automatic.
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Make backup copies of your current Smart Vi ew. exe and ver si on. xni before
deploying the replacement files.

Download the Smart View zip file from either OTN or MOS, as described in
Installing from My Oracle Support or Oracle Technology Network.

Unzip the downloaded file to a temporary location.

Copy Snart Vi ew. exe and versi on. xm to the location of the Oracle Hyperion
Enterprise Performance Management Workspace installation, typically:

C:\Oracl e\ M ddl ewar e\ EPMSyst enl1R1\ common\ epnst at i ¢\ wspace\ Smart Vi ew

This is the epmstatic location specific to Smart View.

Depending on which version of Smart View your users are upgrading from,
perform either Option A OR Option B.

e Option A (Upgrading from 11.1.2.1.x, 11.1.2.2.x, or 11.1.2.3.x)

If your users are upgrading from an installed Smart View version of 11.1.2.1.x,
11.1.2.2.x, or 11.1.2.3.x, open the versi on. xnl file in the epmstatic location
specific to Smart View (see step 5), and edit the value in the i nstal | Fi | e tag to
point to the location of the Smart View executable file (step 5) as follows:

<instal | File>
[ epnstati ¢/ wspace/ Smart Vi ew Smart Vi ew. exe
<linstallFile>

* Option B (Upgrading from 11.1.2.5.000 or Later)

If your users are upgrading from an installed Smart View version 11.1.2.5.000
or later, choose only one of the following options and perform the tasks
described:

— OTN Option

Do not modify the version. xni file in the epmstatic location specific to
Smart View (step 5).

Your users will automatically be directed to the Smart View page on OTN,
where they can download the installation zip file to their own machines,
unzip the contents, and run the installer.

— "epmstatic" Option

Open the version. xn file in the epmstatic location specific to Smart View
(see step 5) and edit the value in the i nstal | Fi | e tag to point to the
location of the Smart View executable file (step 5) as follows:

<installFile>
/ epnst ati ¢/ wspace/ Smart Vi ew Smart Vi ew. exe
<linstallFile>

— Web App Server Option

Post the Smart Vi ew. exe file to a web app server in your environment, and
then modify the versi on. xnl file to point to the fully-qualified URL.

a. Copy only the Smart Vi ew. exe to the web app server where you will be
hosting the file.

b. Open the version. xnl file in the epmstatic location specific to Smart
View (see step 5), and edit the value in the i nstal | Fil e tag to point to
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Installing by Autodeployment in EPM System

the fully-qualified URL where you are hosting the Smart View
executable file (see step a); for example:

<installFile>

http://webServerHost : webSer ver Port/ pat hToSnart Vi ewExe/
Smart Vi ew. exe
<linstal|File>

Your Smart View users can now proceed with Client Installation.

Client Installation

ORACLE

In the previous section, Server Setup, if you chose the OTN Option in Option B, then
your users will be directed to OTN for the Oracle Smart View for Office download. In
that case, your users should follow the instructions for OTN download and installation
in Installing from My Oracle Support or Oracle Technology Network.

If you did not choose the epmstatic Option or Web App Server Option in Option B,
then complete the following procedure.

To install the Smart View client:

1. In Smart View, select Panel.
2. Connect to a data source in one of the following ways:
*  Through a shared connection
*  Through a private connection with the following URL:
— Oracle Essbase: http://<server>: 19000/ aps/ Smart Vi ew

— Oracle Hyperion Planning: http: // <server>: 19000/ Hyper i onPl anni ng/
Smart Vi ew

— Oracle Hyperion Financial Management: htt p: // <server >: 19000/
hf mof f i cepr ovi der/ hf nof fi ceprovi der. aspx

— Oracle Hyperion Reporting and Analysis: http: // <server>: 19000/
raf ramewor k/ br owse/ | i st xni

¢ Note:

If you are using Reporting and Analysis release 11.1.2.1.000 or
earlier, Smart View autodeployment will not work (10233672,
12870087).

3. When the message “New Smart View client version available” is displayed, select

Click here to Install.

4. In the Internet Explorer browser that launches, in File Download, select Run.

" Note:

Internet Explorer will launch even if Firefox is your default browser.

5. If a Microsoft Excel security warning is displayed, select Run.
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Chapter 2
Installing from EPM Workspace

When prompted, confirm the upgrade; click Yes.
The installation wizard is displayed; click OK.

The installer is automatically displayed in the language set in the Format field of
the Windows Region and Language dialog box in the Control Panel.

If prompted, close all open Microsoft Office applications, and then click OK.
In the installation wizard, click OK and follow the prompts to install Smart View.
When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.

Open Excel.
On the Smart View ribbon, select the arrow next to Help, and then select About.

Verify the new version of Smart View.

Installing from EPM Workspace

Related Topics

Workspace Setup

Client Installation

Workspace Setup

To set up the Workspace environment for the updated Oracle Smart View for Office
installer:

1.

Make backup copies of your current Smart Vi ew. exe and ver si on. xni before
deploying the replacement files.

Download the Smart View zip file from either OTN or MOS, as described in
Installing from My Oracle Support or Oracle Technology Network.

Unzip the downloaded file to a temporary location.

Copy Smart Vi ew. exe and versi on. xm to the location of the Oracle Hyperion
Enterprise Performance Management Workspace installation, typically:

C:\Oracl e\ M ddl ewar e\ EPMSyst enl1R1\ conmon\ epnst at i c\ wspace\ Smart Vi ew

Client Installation

To install Oracle Smart View for Office from Oracle Hyperion Enterprise Performance
Management Workspace:

ORACLE

1
2
3.
4

In EPM Workspace, select Tools, then Install, and then Smart View.
In File Download, select Run.

If a Microsoft Excel security warning is displayed, select Run.

Select a destination folder for Smart View, and then click OK.

For new installations, Smart View is installed by default in:

C\Oacl e\ Smart Vi ew
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If you are upgrading an existing installation of Smart View, the installer defaults to
the folder where Smart View was previously installed.

5. When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.

Installing from Oracle Bl EE

Related Topics
»  Configuring the Bl Home Page

* Installing from the Bl Home Page

Configuring the Bl Home Page

ORACLE

# Note:

Configuring a custom download link for the Smart View installer applies to
Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 and later versions,
and might not be available in earlier versions.

Starting in Oracle Bl EE release 11.1.1.9, the Smart View for MS Office link on the
Download Bl Desktop Tools drop-down list points to the Oracle Smart View for Office
download on Oracle Technology Network.

If you do not want to direct your users to Oracle Technology Network, you can
configure the Smart View for MS Office link to point to a custom download link for the
Smart View installer. You can then ensure that the correct version of Smart View for
your environment is always available to your users. Do this by adding the

Smart Vi ewl nst al | er URL element to i nst anceconfi g. xm .

You can configure the download link point to a location where the snart vi ew. exe
resides; for example:

« Anexternal URL

* Aninternal URL, such as internal web page or intranet location where the
installation can start immediately

» Afolder on alocal server where the installation can start immediately

To configure a custom download link for the Smart View installer:

1. Open theinstanceconfig.xn file for editing

Refer to "Where Are Configuration Files Located?" in the Oracle Fusion
Middleware System Administrator's Guide for Oracle Business Intelligence
Enterprise Edition.

2. Locate the Cat al ogPat h and <DSN>Anal yti csWeb</ DSN> sections and add the
Smart Vi ew nst al | er URL element after those sections.

3. Use the syntax in the following examples to add the Snart Vi ew nstal | er URL
element.
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Example for download from Oracle Technology Network:

<Cat al ogPat h>/ exanpl e/ pat h/ wor k/ abc/ i nst ances/ i nst ancel/ bi f oundati on/

Oracl eBl Present ati onSer vi cesConponent / cor eappl i cati on_obi psl/cat al og/ Sanpl eApp</
Cat al ogPat h>

<DSN>Anal yt i cs\Web</ DSN>

<Smart Vi ew nstal | er URL>ht t p: // www. or acl e. coni t echnet wor k/ ni dd| ewar e/ epni

downl oads/ smart - vi ew 1112x- 1939038. ht m </ Smart Vi ew nst al | er URL>

Example for download from an intranet site:

<Cat al ogPat h>/ exanpl e/ pat h/ wor k/ abc/ i nst ances/ i nst ancel/ bi f oundati on/

Oracl eBl Present ati onSer vi cesConponent / cor eappl i cati on_obi psl/cat al og/ Sanpl eApp</
Cat al ogPat h>

<DSN>Anal yti csWeb</ DSN> <Smart Vi ewl nst al | er URL>ht t p: // myser ver: 8080/ downl oads/
smartvi ew. exe</ Smart Vi ew nst al | er URL>

Example for download from an internal server:

<Cat al ogPat h>/ exanpl e/ pat h/ wor k/ abc/ i nst ances/ i nst ancel/ bi f oundati on/

Oracl eBl Present ati onSer vi cesConponent / cor eappl i cati on_obi psl/cat al og/ Sanpl eApp</
Cat al ogPat h>

<DSN>Anal yti cs\Web</ DSN> <Smart Vi ewl nst al | er URL>\\ nyser ver\ downl oads

\'smartvi ew. exe</ Smart Vi ew nstal | er URL>

Save your changes and close the file.

Restart the Oracle Bl EE instance.

Installing from the Bl Home Page

To install Oracle Smart View for Office from Oracle Business Intelligence Home:

ORACLE

1.

o o p W

In the Bl Home page, click the arrow next to Download Bl Desktop Tools, and
then select Smart View for MS Office.

If you are directed to the Smart View download page on Oracle Technology
Network, then follow the procedure in Installing from My Oracle Support or Oracle
Technology Network. Otherwise, proceed with step 2.

Choose an option:
e Click Run to run the installer directly.

If the User Account Control dialog box is displayed, click Yes, and then
continue to step 3.

» Click Save to save the Smart View installer file to a directory to which you
have access and from which you can run executable files.

Open the folder where you saved the Smart View executable and double-click
it to run it. Then continue to step 3.

Select the language to use for the installation wizard.
Click Next.

Follow the prompts in the wizard.

When installation is complete, click Finish.

The Smart View ribbon is displayed the next time you open Microsoft Excel,
PowerPoint, or Word.
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# Note:

Starting with Smart View 11.1.2.5.510, the Oracle Bl EE per-user
extension installer is included with the Smart View client installation.

The extension is installed the first time you start Office if the Oracle Bl
EE extension is not already installed and it is not disabled.

Running Command Line or Silent Installations

ORACLE

Oracle Smart View for Office can be installed from the command line. Additionally,
administrators can enable silent installations—installations that do not require settings
to be specified each time—for Smart View and Smart View extensions. The silent
installation command can be included in scripts to automate installation.

" Note:

Silent installations are only supported for admin users.

Use the options in Table 1 to install Smart View from the command line and for silent
installations.

Related Topics:

e Installing Smart View from the Command Line
e Installing Smart View Silently

e Installing Smart View Extensions Silently

» Registry Settings to Reduce Timeouts and Flickering

Table 2-3 Command Line Options for Smart View Installations

|
Option Usage

IV"command line options" Specifies command line options to be passed
to the Smart View MSI installer.
For example, to specify the installation
directory, use:

/v "I NSTALLDI R=<pat h>"

To enable logging, use:

/v "lI*v <log file path and nanme>"

Is Runs the Smart View installer in silent mode.

[Office=64 Installs or uninstalls only the 64-bit version of
Smart View

/Office=32 Installs or uninstalls only the 32-bit version of
Smart View

/extensionupdatelist= Path to UpdateList.xml
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Table 2-3 (Cont.) Command Line Options for Smart View Installations

________________________________________________________________________|
Option Usage

Ix Uninstalls Smart View

Before You Begin

Before you begin, follow the procedure in Installing from My Oracle Support or Oracle
Technology Network to download the Smart View installation zip file and unzip it to the
folder you will be working in.

Installing Smart View from the Command Line

To install Oracle Smart View for Office from the command line:

1. Open a command prompt.
2. Navigate to the directory of the Smart View installer.
3. Run the installation commands in Table 1; for example:
* Toinstall in the default directory, run:
Smart Vi ew. exe
e Toinstall in another directory, run:

Smart Vi ew. exe /v" | NSTALLDI R=<target path>"

For example:
Smart Vi ew. exe /v" | NSTALLDI R=D:\ Smart Vi ew'
* To specify the location of Updat eLi st. xm , run:
Smart Vi ew. exe /extensionupdatel i st=<path to UpdateList.xm >
e Torun an installation and log the installation sequence:
Smart Vi ew. exe /v” INSTALLDI R=D:\SmartView /L*v c:\install.log”

4. Optional: Run your organization-specific commands to deploy to your users the
Windows Registry settings noted in Registry Settings to Reduce Timeouts and
Flickering.

Installing Smart View Silently

The silent installer wrapper follows these rules:

e It passes the value of the / v parameter intact to the MSI.

e The /s flag is converted to / gn and passed to the MSI. There is no need to specify
the / gn parameter if / s is already present in your script.

e Unless the / v parameter contains any / q specifier, the wrapper passes / gb+ to the
MSI.

To run silent installations:

1. Open acommand prompt.
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2. Navigate to the directory of the Oracle Smart View for Office installer.
3. Run the installation commands in Table 1; for example:
* Toinstall in the default directory, run:
Smart Vi ew. exe /s
* Toinstall in another directory, run:

Smart Vi ew exe /s /v" | NSTALLDI R=<t arget pat h>"

For example:
Smart Vi ew exe /s /v" | NSTALLDI R=D:\ Smart Vi ew'
* To specify the location of Updat eLi st. xm , run:
Smart Vi ew. exe /s /extensionupdatelist=<path to UpdateList.xn >
e Torun a silent installation and log the installation sequence:
SmartView exe /s /v" INSTALLDI R=D:\ SmartView /L*v c:\install.log"

4. Optional: Run your organization-specific commands to deploy to your users the
Windows Registry settings noted in Registry Settings to Reduce Timeouts and
Flickering.

Installing Smart View Extensions Silently

Administrators can push extension installations silently by calling the following
command:

svl aunch. exe /i <path to the extension installer>

For example, after a typical Oracle Smart View for Office installation, Smart View is
installed on C:\ Oracl e\ Smart Vi ew. In this installation, the extensions included with Smart
View are located in C:\ Oracl e\ Smart Vi ewh ext ensi ons. Using the command above, an
admin can silently install the Oracle Journals extension using the following command:

svlaunch.exe /i C\Oacle\Smart Vi ew ext ensi ons\ SYFMJour nal I nst al | er. svext

After installation, the extension files are located on the user's machine here:

UAPPDATA% Or acl e\ Smart Vi ewh ext ensi ons\ Bi n

Reqgistry Settings to Reduce Timeouts and Flickering

ORACLE

Use your own organization-specific procedures to deploy these Windows Registry
settings to your users. These settings can help to reduce timeouts and flickering in
Oracle Smart View for Office.

Timeout Settings
Configure these Registry settings to help reduce timeouts:

e ReceiveTimeout
»  KeepAliveTimeout

e ServerinfoTimeout
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See Smart View HTTP Session Timeout for information on these settings.

Flickering Settings
Configure these Registry settings to help reduce flickering:

* DisableWindowTransitionsOnAddinTaskPanes

* DisableAnimations

# Note:

Oracle recommends setting the registry key,
DisableWindowTransitionsOnAddinTaskPanes, to reduce POV toolbar
flickering. Consider rolling this out this setting to your users along with the
Smart View install.

See Flickering Issues on Office 2013 and Office 2016 for information on these
settings.

Downloading Help for Local or Web Server Installation

ORACLE

After installing Oracle Smart View for Office, the online help is retrieved from a URL
hosted on the Oracle.com web site. This is the default behavior for Smart View, and no
changes are required by users to launch help.

However, you may require that the help be installed locally or on a web server in your
organization. Some examples for the need to access help from a location other than
Oracle.com are:

* Help files must be installed on a local drive on an individual's computer for Section
508 accessibility purposes.

* Internet access limitations; for example, your users only have access to URLs on
your organization's intranet.

To accommodate the above types of cases, a downloadable help zip file is posted on
My Oracle Support as a patch to the current Smart View release.

The procedure below describes downloading the help zip file. Further instructions for
installation and configuration are in the following guides:

e Installing and Configuring Help Locally or on a Web Server in this guide.

e Oracle Smart View for Office Accessibility Guide. See "Installing and Configuring
Help Locally."

To download the Smart View help zip file from My Oracle Support (MOS):

1. Loginto MOS.
2. Select the Patches & Updates tab.

The Patch Search area is displayed at the right of the screen with the Search tab
selected by default.

3. Under the Number/Name or Bug Number (Simple) heading, ensure that Patch
Name or Number is selected in the drop-down list box.
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In the Patch Search text box, type this Smart View patch number:

23206405

The Patch Search text box is to the right of the Patch Name or Number drop-
down list box.

Click Search.
Download the patch zip file to a temporary directory.

To install and configure the help according to your requirements, follow the
instructions in either of the following guides:

» Installing and Configuring Help Locally or on a Web Server in this guide.

*  Oracle Smart View for Office Accessibility Guide. See "Installing and
Configuring Help Locally."

Uninstalling Smart View

This topic describes uninstalling Oracle Smart View for Office.

ORACLE

To uninstall extensions, see "Uninstalling Extensions" in the Oracle Smart View for
Office User's Guide.

To uninstall Smart View:

1.
2.

Before you begin, close all Office applications.

Go to your Windows system Control Panel and navigate to Uninstall or change
a program.

Locate and select the version of Smart View that applies to your installation:
e Oracle Smart View 32-bit for Office

e Oracle Smart View 64-bit for Office

Click Uninstall.
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Administering Extension Installations and
Updates

The extension installation and update process described in this topic enables Oracle
Smart View for Office end users to install, update, or uninstall extensions based on
parameters set by the Smart View administrator in the manifest file, Updat eLi st . xm .

About Extension Installations and Updates

ORACLE

Auto-Update versus Manual Update

In releases earlier than Oracle Smart View for Office 11.1.2.5.400, extensions were
updated using the Auto-Update process. To update extensions with Auto-Update,
Smart View end users could go to the Extensions tab of the Options dialog box and
click the Check for updates link or select the Check for updates when Microsoft
Office starts check box to initiate extension updates. For all extensions, if any
updates were available, they were retrieved and installations were automatically
initiated.

In release 11.1.2.5.400 and later, you can customize the extension update process so
that Smart View end users can control when they install, update, and remove
extensions. The Smart View administrator configures attributes in the Updat eLi st . xni
manifest file to control the options available to the users. If the administrator does not
configure these attributes in Updat eLi st . xnl , extensions will continue to be updated
using the existing Auto-Update process.

Types of Extensions

There are two types of extensions that can be installed on a Smart View client
machine:

* Provider extensions. Extensions that are dependent on, or integrated with,
Oracle components are provider extensions. Examples are the Disclosure
Management and Oracle Hyperion Financial Reporting extensions. Provider
extensions can be configured as required extensions.

* Per-user extensions. Extensions that are installed in the user’s application data
folder. These extensions may or may not be dependent on Oracle components.
Additionally, per-user extensions can also be configured as required extensions.

The Smart View administrator configures the Updat eLi st. xm file to specify the list of
provider and per-user extensions available to end users along with options for
installing, updating, and removing them. Additionally, per-user extensions can also be
configured to display an indicator for required extensions and does not force the
installation. The Smart View end user then accesses the Options dialog box and
installs, updates, or uninstalls the extensions that are available to him or her in the
Extensions tab.

To configure provider and per-user extension installation, uninstallation, and updating,
complete the procedure in Configuring Manual Extension Updates.
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If you do not want to make changes to the extension update process, you may refer to
Configuring Auto-Update Extensions for information on the structure of the XML and
examples, but you do not need to take any further action.

For instructions on installing, updating, and removing extensions in Smart View, end
users can refer to the procedure topics in "Extensions" in the "Smart View Options"
chapter in the Oracle Smart View for Office User's Guide.

About the Oracle Journals for Financial Management Extension

The Oracle Journals extension is unique among Smart View extensions in that the
extension installer file is included in the ext ensi ons folder of the Smart View
installation. End users can install the Oracle Journals extension directly from the
ext ensi ons folder of their Smart View installation.

Or, as administrator, you can control how your Smart View end users install the Oracle
Journals extension, automatically or manually, via the Extensions page of the Smart
View Options dialog box.

If you choose to set up automatic or manual installations of the Oracle Journals
extension, you should install Smart View in a test environment first, then refer to the
Updat eLi st. xni file, found in the ext ensi ons folder of your Smart View installation. Use
the entry in this file as a guideline for the Oracle Journals entry you will add to the
Updat eLi st. xm file, as described in Configuring Manual Extension Updates.

Configuring Manual Extension Updates

ORACLE

Auto-Update extensions in the Updat eLi st. xni manifest file can be configured so that
the Oracle Smart View for Office end user can see the available extensions, including
per-user extensions, and install them from the Extensions tab of the Options dialog
box.

You can add two attributes, vi si bl e and al | owuni nstal | , to the Updat eLi st. xm manifest
file to change the behavior of the extensions from auto-update to manual update so
that the extensions are displayed in the Options dialog box:

* visibl e—A value of "1" indicates that the extension will appear in the Extensions
tab of the Smart View Options dialog and will NOT be part of the Auto-Update
process.

If the vi si bl e attribute is missing or the value is not "1", the extension is included in
the Auto-Update process.

e allowuninstal | —A value of "1" indicates that the user can initiate an uninstall
through the Extensions tab of the Options dialog box using the Remove link.

If the al | owuni nst al | attribute is missing or the value is not "1", the user may not
initiate an uninstall in the Extensions interface (the Remove link will not be there).

This procedure is optional. If you choose not to add the attributes to Updat eLi st . xnl ,
extensions will continue to be updated as they were in releases earlier than
11.1.2.5.400. In pre-11.1.2.5.400 releases, users click the Check for updates link or
select the Check for updates when Microsoft Office starts check box to initiate
extension updates.

See Manual Update XML Defined and Manual Update XML Example for reference.

To add attributes to the Updat eLi st. xni manifest file for extensions:
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Open the Updat eLi st . xnl file for editing.
The manifest file is found in two locations:
° epnstatic:
http://server:port/epnstatic/smartview Cient/UpdateList.xn

*  The location pointed to by the <ext ensi onupdatel i st>tag in C:\Oracle
\ Snart View cfg\properties.xnl.

To populate the <ext ensi onupdat el i st > tag, you can either perform a command
line installation, as described in Running Command Line or Silent Installations,
or manually update the tag in the properties. xnl file.

" Note:

In properties. xn, if multiple URLSs exist for an extension installer,
Smart View checks all locations and installs from the location
containing the latest version.

If multiple URLSs exist for the same version of an extension installer,
Smart View installs from the first URL in the list.

Optional: To display an extension in the Extensions tab of the Options dialog
box, and exclude the extension from the Auto-Update process, add the
vi si bl e="1" attribute to the XML for the extension; for example:

<updat e>
version="11. 1. 2. 3.500. 021"
extension i d="Sone. Uni que. | d. That . Mat ches. Ext ensi on. Descri ptor.|d"
| ocation="/epnstatic/disclosure_ngnt/svext/D scManSet up. msi "
visible="1"
al l owlni nstal | ="1">Cracl e Di scl osure Management

</ ext ensi on>

Figure 1 shows an example of an extension displayed in the Extensions tab.

Figure 3-1 Extension as Displayed in the Extensions Tab

Oracle Predictive Planning 11.1.2.4.000 [¥] Enabled
Oracle Predictive Planning Smart View Extension

# |pdate Available

Optional: To display the Remove button, G Remove | for an extension, add the
al | owuni nstal | ="1" attribute to the XML for the extension; for example:

<updat e>
version="11. 1. 2. 3. 500. 021"
extension id="A. Unique.|d. That. Mat ches. Ext ensi on. Descriptor.|d"
| ocation="/epnstatic/disclosure_ngnt/svext/D scManSet up. msi "
visible="1"
al | owlni nstal | ="1">Cracl e Di scl osure Management

</ extensi on>

Figure 2 shows an example of an extension displayed in the Extensions tab.
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Figure 3-2 Extension as Displayed in the Extensions Tab

Oracle Predictive Planning 11.1.2.4.000 [¥] Enabled 'El' Remave
Oracle Predictive Planning Smart View Extension

* |pdate Available

For each provider and per-user extension, repeat step 2 and step 3 according to
your requirements.

Optional: To remove a single extension from the list of extensions available for
Auto-Update in the Updat eLi st. xmi file, use the alternative method of commenting
out the extension with the <! -- and - - > characters; for example:

<l--

<ext ensi on>

| ocation="/epnstatic/disclosure_ngnt/svext/D scManSet up. msi "
version="11.1.2.4.078" id="nnnnnnnn- nnnn- nnnn- nnnn- nnnnnnnnnnnn"> Or acl e
Di scl osure Managenent

</ ext ensi on>

-->

You can also comment out the entire list of extensions if your goal is to exclude all
extensions from the manual update process.

Manual Update XML Defined

ORACLE

<update>

The root node. This is a tag.

<extension>

Parent node for <extension> attributes. This is a tag.

Attributes of <extension> are:

- id
The extension identifier. The identifier must match the
SVExtensionDescriptor.GUID defined in the extension. It does not need to be
a GUID, it only needs to be unique. This name will appear in the Windows

Registry. For this reason, Oracle recommends using readable identifiers; for
example, Oracle.Disclosure.Management.

— format

A value of "1" indicates that the entry for the extension uses the manual
update XML format introduced in Oracle Smart View for Office 11.1.2.5.400.
This XML format supports more user interface features than the standard
Auto-Update format.

— version

The version number of the extension. The version number must match exactly
with the extension descriptor version in the extension assembly.

— svVersion
The Smart View version that the extension works with.

— visible
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Set this value to "1" to display the extension in the Extensions tab of the
Options dialog box. When this is set to "1", the extension will NOT be part of
the Auto-Update process.

— manualUpdate

Set this value to "1" if the user needs to close Excel for installation update.
The update installer file will be downloaded and a message will be displayed
indicating the required restart of Office. Also, the download folder will be
opened.

— manuallnstall

Set this value to "1" if the user needs to close Excel for installation. The
installer file will be downloaded and a message will be displayed indicating the
required restart of Office. The download folder will be opened.

— allowUninstall

Set this value to "1" to display the Remove button in the Extensions tab of
the Options dialog box.

- lype
The type of extension. Valid values are:
* 0 = optional extension
* 1 = provider extension
* 2 =Smart View client
— required

Set to display a "Required" or "Recommended" icon for the extension. No
action is done other than the visible icon.

e <pame>
The name of the extension. This is a tag.
* <desc>
The extension description. This is a tag.

Uses the "default” attribute. The default description for the extension will be the
description displayed in the Extensions tab.

* owner
The creator or owner of the extension; for example, Oracle.
* location

The location and file name of the extension installer file. This can be nsi or svext;
exe is not supported.

*  <uninstallMsg>
Optional. For uninstalls, displays a custom message to the user.

Uses the "default" attribute. The default description for the uninstallMsg will be the
custom message displayed during uninstall.

e <options>

Optional. For nsi installations only. All options for the Microsoft Windows Installer
Tool, Msi exec. exe, are supported.
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Manual Update XML Example

<updat e>
<extension id="Oracl e. Smart Vi ew. Ext ensi onSanpl es. Power Pack. Adj ust Dat a"
formt="1"
version="1.1.3.0"
svVersion="11.1.2. 2. 310"
visible="1" allowlninstall="1"
manual Updat e=" 0"
manual I nstal | =" 0"
type="0"
required="1">
<name>Adj ust Dat a</ name>
<desc default="Sinple data adjustnment panel for use with Smart View'>
<owner >Or acl e</ owner >
<l ocation>file://server_nane/ shared/ Ext ensionl nstal | ers/ Adj ust Dat al nstal | er. svext
</l ocation>
<uninstal | Msg default="This will renove the extension and all its conponents"
</ uni nstal | Msg>
</ ext ensi on>
</ updat e>

Configuring Auto-Update Extensions

You can add the vi si bl e and al | owlni nstal | attributes to the Updat eLi st. xni manifest
file to change the behavior of the extensions that are part of the Auto-Update process.

If you do not add the attributes to Updat eLi st . xm , extensions will continue to be
updated using the existing Auto-Update process.

To add the visi bl e and al | owni nstal | attributes to the Auto-Update extensions,
complete the procedure in Configuring Manual Extension Updates.

See Auto-Update XML Defined and Auto-Update XML Example for reference.

You can also remove an single extension from the list of extensions available for Auto-
Update in the Updat eLi st. xm file by commenting out the extension using the <! -- and
--> characters. For example:

<I--

<extensi on>

| ocation="/epnstatic/disclosure_ngnt/svext/D scManSet up. nsi " version="11.1.2.4.078"
i d="nnnnnnnn- nnnn- nnnn- nnnn- nnnnnnnnnnnn” > Or acl e Di scl osure Managenent

</ ext ensi on>

-

If you comment out the entire list of extensions, then all extensions are excluded from
the manual update process.

Auto-Update XML Defined

e <update>
The root node. This is a tag.

e <extension>
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Text that contains the extension name. This is a tag. The extension name appears
in the Extensions tab of the Options dialog box. Examples of extension names
are Oracle Predictive Planning Extension, Disclosure Management, or Adjust
Data.

Attributes of <extension> are:

id

The extension identifier. The identifier must match the
SVExtensionDescriptor.GUID defined in the extension. It does not need to be
a GUID, it only needs to be unique. This name will appear in the Windows
Registry. For this reason, Oracle recommends using readable identifiers; for
example, Oracle.Disclosure.Management.

version
The version number of the extension.
location

The location and file name of the extension installer file. This can be nmsi or
svext ; exe is not supported.

operation

Optional. For Auto-Updates, set this value to “delete” to have the uninstall
automatically begin when the user opens Office.

# Note:

The first time a user opens Office, if Oracle Smart View for Office
determines that the extension needs to be uninstalled, the
subsequent opening of Office initiates the uninstall process.

options

Optional. For msi installations only. All options for the Microsoft Windows
Installer Tool, Msiexec.exe, are supported.

visible

Set this value to "1" to display the extension in the Extensions tab of the
Options dialog box. When this is set to "1", the extension will NOT be part of
the Auto-Update process.

allowUninstall

Set this value to "1" to display the Remove button in the Extensions tab of
the Options dialog box.

Auto-Update XML Example

ORACLE

<updat e>

<extension id="A. Unique.|d. That. Mat ches. Ext ensi on. Descriptor.|d"
version="11.1. 2. 3. 500. 021"
| ocation="/epnstatic/disclosure_ngnt/svext/D scManSet up. msi "
visible="1"
al | owlni nstal | ="1">Di scl osure Managenent

</ ext ensi on>
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<extensi on id="Anot her. Uni que. | d"
version="11. 1. 2. 3. 300"
| ocation="/epnstatic/ SoneSet up. nsi "
operation="del ete">Crystal Ball EPM
</ ext ensi on>

<extensi on i d="And. Anot her. Uni que. | d"
version="11. 1. 2. 3. 300"
| ocation="/epnstatic/ SoneSet up. nsi "
options="/pronptrestart">0racle Predictive Planning"
</ ext ensi on>
</ updat e>

Downloading Extensions From Microsoft Internet Explorer

When downloading an extension for Oracle Smart View for Office from Microsoft
Internet Explorer, the filename extension defaults to . ZI P instead of . SVEXT. This
prevents you from being able to double-click to install the extension.

Workarounds:

e When Internet Explorer prompts you to save the file, select Save As, change the
Type to All Files, and then change the extension from . ZI P to . SVEXT. Then,
double-click the downloaded file to install the extension.

» Change the security setting on your machine to allow Internet Explorer to install
the . SVEXT files directly. You must have sufficient security privileges to perform this
task:

1. Select Start, then Control Panel, and then Internet Options.
2. Inthe Internet Properties dialog box, select the Security tab.

3. On the Security tab, under Select a zone to view or change security
settings, click Local intranet.

4. Under Security level for this zone, click Custom level.

5. In the Security Settings - Local Intranet Zone dialog box, scroll down to
Enable MIME Sniffing.

6. Select Disable, and then click OK.

7. Restart Internet Explorer, and then try downloading and running the . SVEXT file
directly from the browser.

Administering Extensions When Using Mozilla Firefox

ORACLE

When using Mozilla Firefox, keep in mind the following:

»  Firefox prevents executable files from being copied and installed from the Internet.
This results in a failure while attempting to install an . SVEXT extension package with
Firefox by selecting the Open with option. As a result, when prompted to save or
run the file, select the Save option, and then double-click the downloaded file to
install the extension .

*  When using Firefox as your web browser to launch Oracle Smart View for Office,
and Firefox opens a browser tab in with an unresolved URL of oracl esv:\\, enable
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the extension for Smart View from the Extensions tab of Firefox Add-ons Manager
and restart Firefox.
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Accessing Shared Connections from an
XML File

Related Topics
» About Accessing Shared Connections from an XML File
e Setting Up the Shared Connections XML File

e Connection File Syntax and Example

About Accessing Shared Connections from an XML File

ORACLE

# Note:

The procedures in this chapter apply to shared connections only.

You can use shared connection information from an XML file to connect to supported
Oracle Smart View for Office providers, both cloud and on-premises. The XML file can
exist either locally on each individual Smart View client machine or on a web server.
Smart View end users point to this XML file in the Shared Connections URL field of
the Options dialog box, and then access the available providers as they would any
other shared connection to which they have access.

To connect to an Oracle Business Intelligence Enterprise Edition provider from the
Shared Connections Panel in Smart View, you must follow the procedures in this topic.
However, you may also connect to Oracle Bl EE data sources from the Private
Connections Panel using the procedure described in "Creating Private Connections" in
the Oracle Smart View for Office User's Guide.

" Note:

Only ASCII characters are supported in the XML file. Do not use non-ASCII
characters in any of the entries you make in this file.

Caution:

The procedures in this chapter should be completed by the Smart View
administrator.
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Setting Up the Shared Connections XML File

Setting up the shared connections XML file involves preparing the XML file distributing
it to your users.

ORACLE

To set up shared connections in an XML file:

1.

Create an empty XML file using any text editor and save it on your Oracle Smart
View for Office client machine.

Give the file a meaningful name, such as Snart Vi ewPr ovi ders. xnl , and ensure that
it has the . xnl extension.

¢ Note:

Only ASCII characters are supported in the XML file. Do not use non-
ASCII characters in any of the entries you make in this file.

Add the following line to the beginning of the file:

<?xm version="1.0" encodi ng="UTF-8"?>

Next, add the opening res_GetProvisionedDataSources tag:
<res_GCet Provi si onedDat aSour ces>

Add entries for the applicable providers.

You can add entries for Oracle Hyperion Provider Services (Oracle Essbase),
Oracle Hyperion Planning (both on-premises and in Oracle Planning and
Budgeting Cloud), Oracle Hyperion Financial Management, Oracle Hyperion
Reporting and Analysis, Oracle Hyperion Strategic Finance, Oracle Business
Intelligence Enterprise Edition, and Oracle Enterprise Performance Reporting
Cloud. The XML can contain entries for supported cloud providers, on-premises
providers, or a mix of both.

When you create your entries, copy the syntax exactly and make ONLY these
substitutions:

* Inthe Product tag, nane attribute:
nane—An internal identifier for the provider. This will not display to users.
e Inthe Product tag, di spl ayVersi on attribute:

ver si on—The version number of the specified provider. This will not display to
users.

e Inthe Server tag, context attribute:
webSer ver Hst —The web server host machine name.

webSer ver Port —The web server port number. Use the default port number that
is already noted in the syntax for each provider. Or, if you have configured
your system using non-default port numbers, provide them.

The syntax for each provider type is below.

Provider Services (Essbase)
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<Product id="APS" nane="name" di spl ayVersion="version">

<Server name="Cracle Hyperion Provider Services" context="http://
webSer ver Host : webSer ver Port/ aps/ Smart Vi ew' ></ Ser ver >

</ Product >

Planning

<Product id="HP" name="name" di spl ayVersion="version">

<Server name="Oracle Hyperion Planning, Fusion Edition" context="http://
webSer ver Host : webSer ver Por t / Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

Financial Management

<Product id="HFM' name="nane" di spl ayVersion="version">

<Server name="Cracle Hyperion Financial Mnagement, Fusion Edition"
context="http://webServerHost: webServerPort/hfmadf/../hfnofficeprovider/
HFMOF f i ceProvi der. aspx" ></ Server >

</ Product >

Reporting and Analysis

<Product id="RAFramework" name="name" di spl ayVersi on="version">
<Server name="Reporting and Analysis Framework" context="http://
webSer ver Host : webSer ver Port / r af r amewor k/ br owse/ | i st XM." ></ Ser ver >
</ Product >

Strategic Finance

<Product provider Type="Ext ensi onProvi der" id="HSF" nanme="name"

di spl ayVer si on="versi on">

<Server name="Oracle Hyperion Strategic Planning, Fusion Edition"

cont ext ="webSer ver Host : webSer ver Port/ Strat egi cPl anni ng/ Smart Vi ew' ></ Ser ver >
</ Product >

Oracle Bl EE

<Product provider Type="Ext ensi onProvi der" id="27EE9BOD- D5F5- 42¢9-
AFC5- 44FEA770C693" name="nane" di spl ayVersi on="versi on">

<Server name="Oracle BlI, Fusion Edition" context="0Bl:http://
webSer ver Host : webSer ver Port/ anal yti cs/ | bi ps"></ Server>

</ Product >

Oracle Planning and Budgeting Cloud

<Product id="HP" name="name" di spl ayVersi on="version">

<Server name="Pl anning and Budgeting C oud" context="http://serviceURL/
Hyperi onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

Oracle Enterprise Planning and Budgeting Cloud

<Product id="HP" name="name" di spl ayVersi on="version">

<Server name="Enterprise Planning and Budgeting C oud" context="http://
servi ceURL/ Hyperi onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

Oracle Enterprise Performance Reporting Cloud

<Product id="EPRCS' nane="nane" displ ayVersion="version">

<Server name="Enterprise Performance Reporting Coud" context="http://
servi ceURL/ epnf Smart Vi ew'> </ Server >

</ Product >
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Oracle Financial Consolidation and Close Cloud

<Product id="HP" name="name" di spl ayVersi on="version">

<Server name="Financial Consolidation and C ose Coud" context="http://
servi ceURL/ Hyperi onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

Oracle Tax Reporting Cloud

<Product id="HP" name="name" di spl ayVersi on="version">

<Server name="Tax Reporting Coud" context="http://serviceURL/ HyperionPl anni ng/
Smart Vi ew' ></ Server >

</ Product >

Optional: If you are planning to access help locally or from an internal URL, add
an entry for locating the help:

* Help installed on a local drive:

<hel purl context>file:///parent_| anguage_fol der _path/ </ hel purl cont ext >

For example:
<hel purl context>file:///C./Craclel SmartVi ew smartvi ew_hel p/ </ hel purl cont ext >
* Help installed on a web server:

<hel purl context >http://webServer Host : webSer ver Port / pat hToHel pFi | es/
smartvi ew_hel p/ </ hel purl cont ext >

For example:

<hel purl context >http://abcxyzco. com 12345/ user _document ati on/
smartvi ew_hel p/ </ hel pur| cont ext >

Notes:

» Perform this step ONLY if you are planning to access shared connections from
an XML file AND are required to access help either from a local drive or a web
server within your organization. See Installing and Configuring Help Locally or
on a Web Server for instructions on setting up help.

» If you use the <hel purl cont ext > tag, the help location you specify overrides the
default or modified location specified in the <hel purl cont ext > tag in the
properties.xnl file, as described in Optional Local Help Configuration via the
Shared Connections XML File.

Optional: Add an entry for the User Productivity Kit (UPK):
<UPK>http://1ink to User Productivity Kit</UPK>

For example:
<UPK>ht t p: / / downl oad. abcxyzco. coml ocondocs/ Pl ayer Package/ dat a/ t oc. ht m </ UPK>

Add the closing res_Get Provi si onedDat aSour ces tag to complete the file, then save
it.

</res_Get Provi si onedDat aSour ces>

See Connection File Syntax and Example for the full syntax and an example of
how this file should be set up.

Test the file:

a. Perform an action:
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» If you plan to have users copy the XML file to their local drive, ensure that
the file is copied to a local drive on your Smart View client machine.

For example, the file may be copied to the Snart Vi ewh bi n directory.

« Alternatively, if you plan to copy the file to a web server, ensure that the
file is accessible to your users from a fully-qualified URL that includes the
XML file name and the . xnl extension.

b. Start Smart View and in the Options dialog box, edit the Shared
Connections URL to add the full path to the file or a URL, ensuring that
the . xnl file name extension is included.

# Note:

This feature will not work if the . xm file name extension in not
included at the end of the local drive path or URL.

* Local drive example:

C./ Oracl e/ Smart Vi ew bi n/ Snart Vi ewPr ovi ders. xm

Ensure that you use forward slashes (/) as separators in the file path.

The directory path and file should now be available in the list of shared
connections.

e Web server URL syntax:

http://webServerHost : webServer Port/ pat hToFi | e/ fi | ename. xm

Web server URL example:

http://abcxyzcowebserver: 1234/ Smart Vi ewDat aSour ces/ Smar t Vi ewPr ovi der s. xn

The URL should now be available in the list of shared connections.

c. Connect to the file using the Shared Connections option in the Smart View
Panel, as described in "Connecting to Data Sources" in the Oracle Smart View
for Office User's Guide.

If you do not see provider entries listed in the Shared Connections drop-
down list, then the XML file may contain incorrect syntax or invalid characters.

Tip:

Verify the XML by opening the file in a browser; for example, in
Internet Explorer. The browser will specify the invalid syntax. Correct
any errors in the XML file editor, save, and refresh the browser
display.

9. When the XML file is correct and complete, perform one of the following
procedures:

» If you plan to have users copy the XML file to their local drive, distribute the file
to your Smart View users with these instructions:
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a. Do not modify this file in any way.
b. Copy the file to a local drive on your Smart View client machine.
For example, the file may be copied to the Snart Vi ewh bi n folder.

c. Start Smart View and in the Options dialog box, edit the Shared
Connections URL with the full path to the file on the local drive, including
the file name and . xni extension; for example:

C./Oracl e/ Smart Vi ew bi n/ Smart Vi ewPr ovi ders. xm

Ensure that you use forward slashes (/) as separators in the file path.

The directory path and file is now available in the list of shared
connections.

d. Test by connecting to the file using the Shared Connections option in the
Smart View Panel, as described in "Connecting to Data Sources" in the
Oracle Smart View for Office User's Guide.

If you have problems connecting, contact your Smart View administrator.

e If you plan to copy the XML file to a web server, notify your Smart View users
with these instructions:

a. Start Smart View and in the Options dialog box, edit the Shared
Connections URL with the URL provided, including the file name
and . xni extension; for example:

http://abcxyzcowebserver: 1234/ Smart Vi ewDat aSour ces/ Smart Vi ewPr ovi der s. xn

b. Test by connecting to this URL using the Shared Connections option in
the Smart View Panel, as described in "Connecting to Data Sources" in
the Oracle Smart View for Office User's Guide.

If you have problems connecting, contact your Smart View administrator.

c. Internet Explorer users: To use the URL given in step a, Oracle
recommends setting the following options in Internet Explorer:

i. Select Tools, then Internet Options.
ii. Inthe General tab, Browsing history group, select Settings.

iii. In the Check for newer versions of stored pages section, select
Every time | visit the webpage, and then click OK.

iv. In the Internet Options dialog box, select the Advanced tab.

v. In the Security section, select the Empty Temporary Internet Files
folder when browser is closed option.

vi. Click OK to close Internet Options and restart the browser.

Connection File Syntax and Example

Related Topics
*  Connection File Syntax

*  Connection File Example
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Connection File Syntax

ORACLE

Below is the file syntax in its entirety:

<?xm version="1.0" encodi ng="UTF-8"?>

<res_Cet Provi si onedDat aSour ces>

<Product id="APS" name="nane" displ ayVersion="version">

<Server name="Cracle Hyperion Provider Services" context="http://

webSer ver Host : webSer ver Por t / aps/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HP" name="name" di spl ayVersion="version">

<Server nanme="Cracle Hyperion Planning, Fusion Edition" context="http://

webSer ver Host : webSer ver Por t / Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HFM' name="nane" di spl ayVersion="version">

<Server name="Cracle Hyperion Financial Mnagement, Fusion Edition" context="http://
webSer ver Host : webSer ver Por t/ hf madf /. . / hf mof fi ceprovi der/ HFMX f i cePr ovi der . aspx” ></
Server >

</ Product >

<Product id="RAFranmework" name="nanme" displ ayVersion="version">

<Server nanme="Reporting and Anal ysis Framework" context="http://

webSer ver Host : webSer ver Por t / r af r amewor k/ br owse/ | i st XML" ></ Ser ver >

</ Product >

<Product provider Type="Ext ensi onProvi der" id="nane" name="HSF-11.1.2"

di spl ayVer si on="versi on">

<Server name="Oracle Hyperion Strategic Planning, Fusion Edition" context="http://
webSer ver Host : webSer ver Port/ St rat egi cPl anni ng/ Smart Vi ew' ></ Server >

</ Product >

<Product provider Type="Ext ensi onProvi der" id="27EE9BOD- D5F5- 42c9- AFC5- 44FEA770C693"
nane="nane" di spl ayVersi on="versi on">

<Server name="COracle Bl, Fusion Edition" context="0Bl:http://

webSer ver Host : webSer ver Port/ anal yti cs/j bi ps"></ Server >

</ Product >

<Product id="HP" name="name" di spl ayVersion="version">

<Server nanme="Pl anning and Budgeting C oud" context="http://serviceURL/

Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HP" name="name" di spl ayVersion="version">

<Server nanme="Enterprise Planning and Budgeting C oud" context="http://serviceURL/
Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="EPRCS' name="nane" displ ayVersi on="version">

<Server name="Enterprise Performance Reporting C oud" context="http://serviceURL/ epm
Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HP" name="name" di spl ayVersion="version">

<Server nane="Financial Consolidation and C ose O oud" context="http://serviceURL/
Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HP" name="name" di spl ayVersion="version">

<Server nanme="Tax Reporting C oud" context="http://serviceURL/ HyperionPl anni ng/
Smart Vi ew' ></ Ser ver >

</ Product >

<hel purl context>a valid entry as per optional step 5</hel purlcontext>
<UPK>http://link to User Productivity Kit</UPK>

</res_Get Provi si onedDat aSour ces>
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Connection File Example

ORACLE

The following example includes an entry for each provider type and also includes an
entry for accessing help from an organization's internal web server:

<?xm version="1.0" encodi ng="UTF-8"?>

<res_Cet Provi si onedDat aSour ces>

<Product id="APS" name="APS-11.1.2" displayVersion="11.1.2.2.500">

<Server nanme="Cracle Hyperion Provider Services" context="http://abcsvr.xyzco.com
19000/ aps/ Smart Vi ew' ></ Server >

</ Product >

<Product id="HP" name="HP-11.1.2" displayVersion="11.1.2.2.000">

<Server name="Cracle Hyperion Planning, Fusion Edition" context="http://

abcsvr. xyzco. com 19000/ Hyper i onPl anni ng/ Smart Vi ew' ></ Server >

</ Product >

<Product id="HFM' name="HFM 11.1.2" displayVersion="11.1.2.2.300">

<Server name="Cracle Hyperion Financial Mnagement, Fusion Edition" context="http://
abcsvr. xyzco. com 19000/ hf madf /. . / hf nof fi ceprovi der/ HFMOf fi ceProvi der . aspx" ></ Server >
</ Product >

<Product id="RAFranmework" name="RAFramework-11.1.2" displayVersion="11.1.2.2.000">
<Server name="Reporting and Analysis Framework" context="http://abcsvr.xyzco.com
19000/ r af r amewor k/ br owse/ | i st XML" ></ Ser ver >

</ Product >

<Product provider Type="Ext ensi onProvi der" id="HSF" name="HSF-11.1.2"

di spl ayVersion="11.1. 2. 2. 00. 2266" >

<Server name="Cracle Hyperion Strategic Planning, Fusion Edition" context="http://
abcsvr. xyzco. com com 8900/ Strat egi cPl anni ng/ Smart Vi ew' ></ Server >

</ Product >

<Product provider Type="Ext ensi onProvi der" id="27EE9BOD- D5F5- 42c9- AFC5- 44FEA770C693"
nane="0Bl EE-11.1.1.7" displayVersion="11.1.1.7">

<Server name="Cracle Bl, Fusion Edition" context="0Bl:http://abcsvr.xyzco.com 9704/
anal ytics/j bi ps"></ Server>

</ Product >

<Product id="HP" name="PBCS" displ ayVersion="17.02">

<Server nane="Pl anning and Budgeting Cl oud" context="http://

mypbcs. nycl oud. or acl ecor p. cont Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HP" name="EPBCS" displ ayVersion="17.02">

<Server name="Enterprise Planning and Budgeting C oud" context="http://

myepbcs. mycl oud. or acl ecor p. con Hyperi onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="EPRCS' name="EPRCS' di spl ayVersion="16.12">

<Server name="Enterprise Performance Reporting C oud" context="http://

myepr cs. mycl oud. or acl ecor p. com epni Snart Vi ew' ></ Server >

</ Product >

<Product id="HP" nanme="FCCS" di spl ayVersion="16.12">

<Server nanme="Financial Consolidation and C ose O oud" context="http://serviceURL/
Hyper i onPl anni ng/ Smart Vi ew' ></ Ser ver >

</ Product >

<Product id="HP" name="TRCS" di spl ayVersion="17.02">

<Server nanme="Tax Reporting C oud" context="http://serviceURL/ HyperionPl anni ng/
Smart Vi ew' ></ Ser ver >

</ Product >

<hel pur | cont ext >http://abcxyzcowebserver: 12345/ user _document ati on/ smart vi ew_hel p/ </
hel purl cont ext >

<UPK>ht t p: / / downl oad. abcxyzco. com ocondocs/ Pl ayer Package/ dat a/ t oc. ht m </ UPK>
</res_Get Provi si onedDat aSour ces>
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Installing and Configuring Help Locally or
on a Web Server

Related Topics
e About Installing Help Locally or on a Web Server
e Setting Up Help Locally or on a Web Server

e Optional Local Help Configuration via the Shared Connections XML File

About Installing Help Locally or on a Web Server

After installing Oracle Smart View for Office, the online help is accessed from a URL
hosted on the Oracle.com web site. This is the default behavior for Smart View, and no
changes are required by users to launch help.

However, you may require that the help be installed locally or on a web server in your
organization. Some examples for the need to access help from a location other than
Oracle.com are:

* Help files must be installed on a local drive on an individual's computer for Section
508 accessibility purposes.

* Internet access limitations; for example, your users only have access to URLS on
your organization's intranet.

To accommodate the above types of cases, a help zip file can be downloaded from My
Oracle Support. You unzip the help to a local drive or web server, and then modify the
Smart View properties. xni file to point the help location.

# Note:

Depending on your requirements, you may also want to specify the

<hel purl cont ext > tag in a shared connections XML file, as described in
Setting Up the Shared Connections XML File of Accessing Shared
Connections from an XML File. Refer to Optional Local Help Configuration
via the Shared Connections XML File for more information.

Setting Up Help Locally or on a Web Server

ORACLE

To install and configure Oracle Smart View for Office help locally or on a web server:

1. Obtain the help zip file for this release from My Oracle Support.

2. Extract the contents to either a local folder on the computer where Smart View is
installed or to a folder accessible by your users on an HTTP web server in your
organization.
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For example:
» Extract the contents locally to:

C:\Oacl e\ Smart Vi ewk

The extraction adds an additional folder named snartvi ew hel p. The result is:
C\Oacle\ Smart Vi ew smartvi ew_hel p
»  Extract the contents to a web server:

http://webServerHost : webSer ver Port/ pat hToHel pFi | es

The extractions adds smart vi ew_hel p after pat hToHel pFi | es. The result is:
http://webServer Host : webServer Port/ pat hToHel pFi | es/ smartvi ew_hel p
Under the smart vi ew_hel p folder, there are 28 language folders; for example:

C:\Oracl e\ Snart Vi ew
\'smartvi ew_hel p
\ar
\cs
\da
\de
\el
\en
\es
\fi
\fr
\fr_CA
\he
\ hu
\it
\ja
\ ko
\nl
\no
\ pl
\ pt
\pt_BR
\ro
\ru
\' sk
\sv
\th
\tr
\zh_CN
\zh_TW

The following language folders contain translated versions of the Smart View help:

\de
\es
\fr
\it
\ja
\ ko
\nl
\pt_BR
\zh_CN
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\zh_TW

The remaining language folders contain the English version of the help. When you
run Smart View in one of those languages (for example, Swedish) and you click a
button for Help, the English help is displayed.

Additionally, the English folder contains a copy of the help in PDF format,
smartvi ew_user. pdf .

Modify the hel purl cont ext property in the Smart View properties. xn file:
a. Inyour Smart View installation, navigate to the Snart Vi ew\ cf g folder.
b. Make a backup copy of the original properties. xn file.

c. Open properties.xn for editing.

d. Modify the hel pur | cont ext property, providing the path to the folder that is
parent to the language folders using the following syntax:

» Ifinstalling locally, provide the path to the folder that is parent to the
language folders using the following syntax:

<hel purl context>file:///parent_| anguage_f ol der _pat h/ </ hel purl cont ext >

Tip:

Use forward slashes in the syntax and ensure that you enter a
final forward slash (/) after the parent language folder path that
you provide.

Using the example from step 2, after extracting the zip contents to C.

\ Oracl e\ Smar t Vi ew, the smartvi ew_hel p folder is the parent folder of the
language folders. Thus, you would modify the
parent_language_folder_path placeholder as follows:

<hel purl context>file:///C/Cracl e/ Smart Vi ew smartview_hel p/ </
hel purl cont ext >

« Ifiinstalling on a web server, provide the path to the folder that is parent to
the language folders using the following syntax:

<hel purl context >http://webServerHost : webSer ver Port/ pat hToHel pFi | es/
smartvi ew_hel p/ </ hel purl cont ext>

Tip:

Use forward slashes in the syntax and ensure that you enter a
final forward slash (/) after the parent language folder path that
you provide.

Using the example from step 2 and substituting user _docunent at i on for
pat hToHel pFi | es, after extracting the zip contents to htt p://abcxyzco. com
12345/ user _docunent ati on, the smartvi ew_hel p folder is the parent folder of
the language folders. For example:
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<hel purl context >http://abcxyzco. com 12345/ user _document at i on/
smartvi ew_hel p/ </ hel purl cont ext >

4. Restart your Microsoft Office applications and access the help from the Smart
View ribbon.

5. Repeat this procedure for each computer that requires Smart View local help.

Optional Local Help Configuration via the Shared
Connections XML File

ORACLE

In a new installation, Oracle Smart View for Office help is available as soon as you
start Excel. You do not need to be connected to a Smart View provider in order to view
the help. After making the changes to the properties. xnl file described in this chapter,
help is accessed from the help location you indicate.

If you are also planning to access shared connections from an XML file (as described
in Accessing Shared Connections from an XML File), AND you require an alternative
location for the help, note the following:

* You can add the <hel purl cont ext > tag to the shared connections XML file. The
help location you specify in the shared connections XML file overrides the help
location specified in properties. xnl once you click the Shared Connections
button in the Smart View Panel. This is true whether or not you modify the
<hel purl cont ext > tag in properties. xm .

» If you do not add or specify the <hel pur| cont ext > tag to the shared connections
XML file, then the local help defined in the properties. xm file will ALWAYS be
used and is available as soon as you start Excel.
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* Issues with Dynamic Data Exchange Option in Excel
» Performance and Memory Usage Considerations for Smart View with Excel
* Unbalanced Loads in Provider Services Clustered Environments

* Two-Way SSL and Problematic Certificates

Diagnostics Tools and Health Check

ORACLE

Diagnostic Tools

Health Check

Diagnostic Tools

When an issue arises while using Oracle Smart View for Office that you cannot resolve
on your own, use the Smart View Diagnostic tools to create and collect log files and
screenshots to send to Oracle Support. When you are finished collecting diagnostic
data, you use the diagnostic tools to zip up the files. Then you transmit the ZIP file to
Oracle Support for analysis. The log files and screenshots are used by Oracle Support
to troubleshoot and resolve your issue.

The Smart View Diagnostic tools are located in the Diagnostics group in the Smart
View ribbon. You enable the display of the tools by

You can customize certain features of Smart View Diagnostic tools; for example:

* Hide data values in an Office document.

* Hide member names in an Office document.

» Direct the diagnostics output files to a folder other than the default.

» Allow automatic screenshots for each warning or error message that is displayed.
See Smart View Diagnostics in the Oracle Smart View for Office User's Guide for more
information on the Diagnostics tools.

Health Check

You can perform a "health check" on your system to optimize performance and to get
information about your machine, Microsoft Office version, Smart View version, and the
extensions you have installed.

You can view the following information about your system:

*  Version Information—Operating System, Excel Version, Smart View Version

» Hardware Information—RAM Memory, Processor, Smart View Installed Drive
Space

» Excel Add-ins—Depends on the Excel add-ins that are installed
* COM Add-ins—Depends on the COM add-ins that are installed

You can make the following changes to system settings and Smart View options:

* Registry Information
— KeepAlive Timeout

— Receive Timeout
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— Serverinfo Timeout
*  Smart View Options
— Undo Buffer
— Improve Metadata Storage
*  Graphic Setting
— Disable Windows Transitions on Addin Task Panes
— Disable Animations

For more information, see "Performing a Health Check On Your System" in the Oracle
Smart View for Office User's Guide.

Installation and Languages

Windows,

ORACLE

The Oracle Smart View for Office installer uses the language set in the Format field of
the Windows Region and Language dialog box, Formats tab. This language also
becomes the default language when running Smart View.

After installation, anytime you change the Smart View language setting (Options
dialog box, Advanced tab), Smart View remembers the new setting on each
subsequent launch of Excel.

To return Smart View to the default language, you can use either of the following
methods in the Options dialog box, Advanced tab:

e Click the Reset button.

* Select the first option in the Language drop-down list. This is always Default,
which is the language specified in the Region and Language dialog box,
Formats tab

After uninstalling and then reinstalling, Smart View reverts to the language specified in
the Windows Region and Language dialog box, Formats tab, and not the last
language specified in the Smart View Options dialog box, Advanced tab.

Office, and Smart View Locale Settings

On each Oracle Smart View for Office client machine, the following locale settings
should match:

*  Smart View language option
*  Microsoft Office language

*  Windows Regional Settings
*  Windows operating system

Running Smart View in a language other than the language of the machine's Windows
operating system, system locale, or Office language, may result in incorrect data being
returned. For example, if the Windows operating system, system locale, and Office
language are English, and you run Smart View in Russian, reports or chart data may
display incorrectly.
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Office .NET Installation Option Requirement

During Microsoft Office installation, you must enable the .NET installation option.
When enabled, files are placed in your Office installation that support interoperability
between Office and other programs and add-ins, such as Oracle Smart View for Office
and Smart View extensions.

Smart View works with these Office interop files:

e Mcrosoft.Ofice.Interop. Excel

* Mcrosoft.Office.|nterop. Power poi nt
e Mcrosoft.Ofice.Interop. Wrd

* Mcrosoft.Office.lnterop. Qutl ook

If these files are not installed, Smart View does not behave as expected. For example,
when connected to Oracle Enterprise Performance Reporting Cloud, you may see a
blank report package panel, resulting in an exception error when clicking in your Office
application. Additionally, in the Smart View log file, you will get errors for an Office
interop file; for example:

System | O Fi | eNot FoundException: Could not load file or assenbly
"Mcrosoft. Office.Interop. Power Poi nt
Could not load file or assenbly 'Mcrosoft. Office.|nterop. Power Poi nt

If you see errors in the Smart View log file such as the one shown above, reinstall
Office and ensure that the .NET option is enabled.

Microsoft Office 365 ProPlus Support

A known issue with Microsoft Office 365 ProPlus patch 16.0.10228.20051, updated
through the insider slow channel, prevents users from accessing Oracle Smart View
for Office with Office 365, resulting in the “Member not found” message being
displayed. This Microsoft patch was pushed to users who signed up for monthly
channel updates between June 12 and June 14, 2018.

Workaround: Update Office with Microsoft Office 365 Version 1806 (Build
10228.20080), which contains the fix for this issue.

Installing in Program Files Folder on Windows 10

On Windows 10, non-administrator users are not authorized to modify the Program
Fi | es folder. Therefore, if an administrator installs Oracle Smart View for Office in
Program Fi | es, a non-admin user will not be able to uninstall Smart View.

By default, Smart View is installed in C:\ Oracl e\ Smart Vi ew, not in the Program Fi | es
folder.

Installing a Pre 11.1.2.5.510 Version of Smart View

If you have installed Oracle Smart View for Office 11.1.2.5.510 or later, and you want
to go to a pre-11.1.2.5.510 version, you must first perform these steps to remove the
Oracle Bl EE extension installation:
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1. Inthe Smart View ribbon, go the Options dialog box, Extensions tab, and click
the Check for Updates, New Installs, and Uninstalls link.

2. Locate the Oracle Bl EE extension in the list, and clear the Enabled check box.
3. Click Remove.

4. Close and restart Office to verify that the Oracle Bl EE extension is removed from
the list in the Extensions tab.

5. Close all Office applications.
6. Uninstall Smart View from the Windows Control Panel.

7. Afterinstalling a pre-11.1.2.5.510 version of Smart View, go the Options dialog
box, Extensions tab, to verify that the Oracle Bl EE extension is enabled.

VBA Function Error for Oracle Analytics Cloud or Oracle Bl

EE

28791548 -- After uninstalling and reinstalling Oracle Smart View for Office, the
following error was displaying when using a VBA function for Oracle Analytics Cloud or
Oracle Business Intelligence Enterprise Edition:

Error '-2147024894(800700002)' : Automation error The system cannot find the file
speci fied.

In some cases, when Smart View is installed as administrator, the uninstall and
reinstall does not handle registration of the Oracle Bl EE extension file correctly.

To remedy this issue, after installation, and before starting Office, install the Oracle Bl
EE extension manually:

1. After uninistalling and reinstalling Smart View, ensure that all Office applications
remain closed.

2. Navigate to C:\ Oracl e\ Smart Vi ew\ ext ensi ons and double-click on
JBI PSProvi derInstal | er.svext.

3. Inthe message that indicates successful installation, click OK.

The Oracle Bl EE extension installation is complete and you may start Office.

Disclosure Management Autodeployment Issue

ORACLE

18347708 -- Disclosure Management 11.1.2.4.0.78 will always trigger the
autodeployment process. To work around this issue, update the version number for
Disclosure Management in the Oracle Smart View for Office Updat eLi st. xni file:

From: version="11.1.2.4.078"
To: version="11.1.2.4.0.78"

For information on modifying the Updat eLi st. xnl file, see the Oracle Smart View for
Office Installation and Configuration Guide, "Administering Extension Installations and
Updates" chapter.
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Failure Connecting to Oracle Analytics Cloud

ORACLE

Issue

In some cases, in an Oracle Analytics Cloud production environment, users may have
issues connecting to Oracle Analytics Cloud from their Oracle Smart View for Office
installation.

This is the type of scenario where this situation can occur:

e Users connect to Oracle Analytics Cloud via VPN

e Oracle Analytics Cloud is protected by Oracle Identity Cloud Service, which is
requested through an Internet Proxy

* Oracle Identity Cloud Service is integrated with a federated single-signon system,
such as Ping Identity

» Users on two different domains install Smart View via a package, delivered using
Microsoft Application Virtualization (Microsoft App-V)

When trying to connect, an empty login screen pops up repeatedly, and then the login
finally fails. This can happen when pasting a connection URL in the Private
Connection Panel.

Cause

The root cause for this issue is that the Smart View packaged version, prior to login,
opened a browser process named i el owuti | . exe. The non-packaged local install of
Smart View, or packaged install with Micorosoft Internet Explorer already running, both
launched i expl or e. exe instead.

Theiel owtil.exe file is a special protected version of Internet Explorer named "Low
MIC [Medium Integrity Cookie] Utility." It prevents the sharing of cookie data between
processes of differing integrity.

This can explain why login to Oracle Analytics Cloud likely fails — since it requires
cookie information that is set by both Oracle Identity Cloud Service and Ping Identity,
and continues to assume the user is not logged in — redirecting back to Oracle Identity
Cloud Service in a loop that escapes only after 12 times.

Solution

Using Process Monitor (Windows Sysinternals), the registry key used to read the
browser was different in each case and was identified as followed:

*  Working Key:

HKEY_CLASSES_ROOT\ Wow6432Node\ CLSI D\ { 0002DF01- 0000- 0000~ C000- 000000000046} \
(Defaul t)

Presents the value:
Internet Explorer(Ver 1.0)
*  Non-working Key:

HKEY_CLASSES_ROOT\ Ww6432Node\ CLSI D\ { 0002DF01- 0000- 0000-
C000- 000000000046} \ Local Server 32\ (Def aul t)

Presents the value:
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"O®rograntil es(x86) % I nternet Explorer\ielowitil.exe" -CLSID:
{0002DF01- 0000- 0000- CO00- 000000000046}

The registry key:

HKEY_CLASSES_ROOT\ Wow6432Node\ CLSI D\ { 0002DF01- 0000- 0000-
C000- 000000000046} \ Local Server 32\ (Def aul t)

is a pointer to:

HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Ww6432Node\ CLSI D\ { 0002DF01- 0000- 0000-
C000- 000000000046} \ Local Server 32\ (Defaul t)

Changing this key to a new value of:
"OFrogranfi | es(x86) % I nternet Explorer\iexplore.exe"

results in the Smart View package calling i expl or e. exe instead, and the login
succeeding.

All registry checks and changes must be done in the same App-V Package/Version ID
environment as the Smart View package, ensuring that the local system is left intact;
that is:

regedit /appvve: 307790F2- DE31- 4EBE- B3BC- 4C9337032E73_0BE1C6E6- 85CC- 48C3-
AOFF- 3BBB789681C3

Since users generally do not have admin access, you may roll out the fix to
HKEY_CURRENT_USER by adding the key to the same path:

HKEY_CURRENT_USER\ Sof t war e\ O asses\ Ww6432Node\ CLSI D\ { 0002DF01- 0000- 0000-
C000- 000000000046} \ Local Server 32\ (Defaul t)

In the case of different Smart View packaged versions (some in an App-V connection
group) across different domains, a PowerShell script can been written to identify the
Smart View packages and make the correct registry changes.

Testing, this key change should result in Smart View users being able to successfully
and consistently log in to Oracle Analytics Cloud.

Smart View Ribbon Fails to Display After Non-Admin
Installation on Windows 10

ORACLE

In some cases, installing Oracle Smart View for Office on Windows 10 as a hon-admin
can cause the Smart View ribbon to fail to display.

In a non-admin install, you double-click the Smart Vi ew. exe file to launch the installer. In
an admin install, you right-click Snart Vi ew. exe and select Run as administrator.

If you installed Smart View as a non-admin and the Smart View ribbon does not
display, complete the following procedures to troubleshoot this issue:

Add the COM Add-in

Reinstall Smart View as Administrator

Add the COM Add-in
To add the Smart View COM add-in:
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Go to File, then Options, and then Add-ins.
From Manage, select COM Add-ins, and then Go.

In COM Add-ins, select the check box to enable the Oracle Smart View for
Office add-in, and click OK.

Restart Excel.

If the Smart View ribbon does not display after restarting Excel, proceed to
Reinstall Smart View as Administrator

Reinstall Smart View as Administrator

If the Smart View ribbon still fails to display after adding the COM add-in, perform
these steps:

1.

Uninstall Smart View.
See Uninstalling Smart View for more information.

Reinstall Smart View by right-clicking Smart Vi ew. exe and selecting Run as
administrator.

See Installing from My Oracle Support or Oracle Technology Network for more
information.

Launch Excel and verify that the Smart View ribbon is displayed.

Error When First Launching Excel After Installing Smart

View

ORACLE

After installing Oracle Smart View for Office and launching Excel for the first time, you
may get an error message similar to the following: "Unable to set the installed property
of the add-in class.”

Workarounds: Enable the Smart View Excel add-in using one of the following
methods:

Trust Center Method

1.

6.
7.

Perform the task appropriate for your Office version:
* 2016, 2013, 2010: Go to File, then Options, and then Trust Center.

e 2007: Click the Office button in the top left corner of Excel, then select Excel
Options, and then Trust Center.

Click the Trust Center Settings button.
In the left pane, select Trusted Locations.

Click Add new location to launch the Microsoft Office Trusted Location dialog
box.

In Path, enter the path to the Smart View bin folder; for example:
C:\Oracl e\ Smart Vi ew\ bin
Click OK.

Click OK to close the Trust Center, and then click OK to close Excel Options.

COM Add-ins Method:
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1. Perform the task appropriate for your Office version:
° 2016, 2013, 2010: Go to File, then Options, and then Add-ins.

e 2007: Click the Office button in the top left corner of Excel, then select Excel
Options, and then Add-ins.

2. From Manage, select COM Add-ins, and then Go.

3. In COM Add-ins, select the check box to enable the Oracle Smart View for
Office add-in, and click OK.

Issues When Starting Excel in Automation Mode

ORACLE

In some cases, third-party software that automates Excel processes, such as
exporting to Excel, may cause issues with Excel and a conflict with Oracle Smart View
for Office.

Workaround:

To disable Smart View when Excel is started in automation mode, you may enable
"DisablelnAutomation” by adding a key and key value to the Windows Registry. To do
this, create the Options key and DisablelnAutomation key value as follows:

* Key Name:

[ HKEY_CURRENT_USER\ Sof t war e\ Or acl e\ Smart Vi ewh Opt i ons]
* Key Value:

"Di sabl el nAut omat i on" =dwor d: 00000001

When set to 00000001, Smart View is disabled when Excel is started in automation
mode. Smart View starts correctly when Excel is started manually, outside of an
automated process.

When set to 0 or not created at all, then Smart View is enabled and starts when
Excel is started in automation mode, which may cause issues. Smart View starts
correctly when Excel is started manually, outside of an automated process.

Creating the Registry Key and Key Value

To create and update the registry key, Options:

1. Click Start, click Run, type regedi t in the Open box, and then click OK.
2. Locate and then select the following registry subkey:
HKEY_CURRENT_USER\ Sof t war e\ Or acl e\ Smart Vi ewt

From the Edit menu, select New, and then select Key.

Type Opti ons, and then press Enter.

From the Edit menu, select New, and then select DWORD Value.
Type Di sabl el nAut onat i on, and then press Enter.

In the Details pane, right-click DisablelnAutomation, and then click Modify.

® N o 0 s

In the Value data box, type 00000001, and then click OK.

The value, 00000001, enables the DisablelnAutomation key.
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# Note:

If a zero value is entered, then this option is disabled.

9. Exit Registry Editor.
10. Restart Excel.

Enabling and Disabling Smart View and Other Office Add-
INS
You can enable and disable Oracle Smart View for Office and other Microsoft Office

add-ins from the Add-Ins tab in Excel Options. In some cases, Smart View
performance can be improved when other Office add-ins are disabled.

To enable or disable Smart View or other Office add-ins for all applicable Office
applications (including Outlook):

1. Open Excel, Word or PowerPoint.
Do not use Outlook to enable and disable Office add-ins.
2. Perform the task appropriate for your Office version:
e 2016, 2013, 2010: Go to File, then Options, and then Add-Ins.

e 2007: Click the Office button in the top left corner of Excel, then select Excel
Options, and then Add-Ins.

Continue with step 3 to work with COM Add-ins. Continue with step 4 to work with
Excel Add-ins.

3. Toenable or disable COM add-ins, from Manage, select COM Add-ins, then click
Go and then perform a task:

* To enable add-ins, ensure that the check box next to the add-in is checked.

If the check box next to the add-in is cleared, then click the check box to select
it, and then click OK.

If the add-in you want to enable is not in the list, click Add, navigate to the
location of the add-in file in your system and select it, then click OK, and then
click OK again in the COM Add-Ins dialog to close it.

» To disable add-ins, ensure that the check box next to the add-in is cleared.

If the check box next to the add-in is checked, then click the check box to clear
it, and then click OK.

In the following example COM Add-Ins dialog box, the Acrobat PDFMaker Office
COM Addin, is disabled; other available add-ins are enabled, including Smart
View.
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|

Add-Ins available:

oo D g N NS RN e

W] 2crobat PDFMaker Office COM Addin A [:

Orade Beehive Add-In for Office Ca

Orade Smart View for Office

Send to Bluetooth :
Ad
Rerr

Location: C:\Program Files (x36)\ddobe\Acrobat 2015\PDFMaker WO ffice \PDFMOffice Addin. dll

Load Behavior: Load at Startup

To enable or disable Excel add-ins, from Manage, select Excel Add-ins, then
click Go and then perform a task:

e To enable add-ins, ensure that the check box next to the add-in is checked.

If the check box next to the add-in is cleared, then click the check box to select
it, and then click OK.

If the add-in you want to enable is not in the list, click Browse, navigate to the
location of the add-in file in your system and select it, then click OK, and then
click OK again in the COM Add-Ins dialog to close it.

e To disable add-ins, ensure that the check box next to the add-in is cleared.

If the check box next to the add-in is checked, then click the check box to clear
it, and then click OK.

In the following example Add-Ins dialog box, the Smart View add-in, Hstbar, is
disabled; other available add-ins are enabled. Note that these add-ins are not
related to Smart View.

ORACLE"

6-11



Chapter 6
Extension Installation from EPM Cloud and Message Window Focus

l" ™
Add-Ins [

Add-Ins available:

E Analysis ToolPak - 0K

| Analysis ToolPak - VBA

V] Conditional Sum Wizard
Euro Currency Toals

s

..... B e
"F|Internet Assistant VBA SR

[¥] Lockup Wizard :

[¥] solver Add-in

Hsthar

ki

5. Restart any open Office applications.

Extension Installation from EPM Cloud and Message
Window Focus

ORACLE

Installing extensions from supported Oracle Enterprise Performance Management
Cloud services involves downloading an extension installer file and double-clicking it.
When double-clicking an extension installer (. svext), a message window is displayed
indicating the success or failure of the installation. The message window can
sometimes lose focus and go behind another open window, and can easily go
unnoticed. This may lead to users trying to install the extension again, causing an error
due to the previous open message window having a hold on the folder and files.

To clean up this extension installation issue:
1. Close all Office applications (Excel, Word, PowerPoint, Outlook).
2. Check the Windows task bar for an existing message window, and close it.
3. Remove prior extension installations:
a. Navigate to %ppDat a% O acl e\ Smart Vi ewk ext ensi ons\ bi n
b. Delete the extension folder.

For example, to delete the Oracle Enterprise Performance Reporting Cloud
extension folder, delete the Oracl e. Smart Vi ew. EPRCSExt ensi on folder.

c. Delete the extension installation folder.

For example, to delete the Oracle Enterprise Performance Reporting Cloud
extension installation folder, delete the EPRCSProvi der I nst al | er folder.
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4. Remove pending installations:
a. Navigate to %ppDat a% O acl e\ Smart Vi ew\ ext ensi ons\ updat e
b. Delete the pending extension installation folder.

For example, to delete the Oracle Enterprise Performance Reporting Cloud
pending extension installation folder, then delete the
Oracl e. Smart Vi ew. EPRCSExt ensi on folder.

5. Return to the location where you previously downloaded the extension installer
file, and double-click it.

For example, to install the Oracle Enterprise Performance Reporting Cloud
extension, double-click EPRCSPr ovi der | nstal | er. svext .

6. Open Excel, Word, or PowerPoint, and in the Smart View ribbon, click Options,
then select Extensions, and then verify that the extension you installed is listed.

Extension Updates and Office Applications Remaining Open

In order for extensions to be properly installed, removed, or updated, all Office
applications must be shut down. When an Office application is reopened, updates for
extensions are applied.

Sometimes, even though an Office application has been closed, it does not completely
shut down, or does not shut down in a timely manner. In these cases, an instance of
Office is still running and Oracle Smart View for Office is unable to apply the extension
updates correctly.

For these situations, it may be necessary to open the Windows Task Manager and
look for possible Office applications that may still be running. For Windows 10 users,
navigate to the Details tab to find the correct process hame corresponding to the
Office applications. Other Windows version users, navigate to the Processes tab.
Application names to look for are Excel.exe, Outlook.exe, PowerPnt.exe, and
Winword.exe.

If any of these application names are displayed in the Task Manager, click on the
name and end the process.

Once all Office applications are closed, reopen one of the applications so that Smart
View can apply pending updates.

Slowness with Extension Options Dialog Box
When opening the Extensions tab of the Options dialog box or when checking for

extension updates, if your system seems to be taking a long time to complete these
tasks, ensure that the machine has access to the internet.

Office Slow to Start when Internet Connectivity is Not
Available

When starting Office, Oracle Smart View for Office performs various security checks at
startup, including checks on all the installed extensions. Internet connectivity is
required in order to perform these checks.
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Without internet connectivity, the security checks on extensions cannot be carried out
and Office applications will be very slow to launch.

You may disable extensions in order to improve Office startup time, but you will lose
the functionality related to those extensions, even if you are still able to connect to
data providers through your company's intranet.

Oracle recommends verifying that you can connect to the internet when starting Office
with Smart View installed.

Excel Process Stops Responding (Hangs) on Shut Down

Excel may be slow to shut down if the Excel 15. x| b file is corrupted. This file stores
changes to the ribbons in Excel.

A simple fix to this issue is to rename Excel 15. x| b. A clean Excel 15. x| b file is
rebuilt the next time you start Excel.

The Excel 15. x| b file is located in the C: \ User s\ user \ AppDat a\ Roami ng
\ M crosoft\Excel folder.

To rename the Excel 15. x| b file:

1. Close any open Excel applications and ensure that all excel . exe processes in the
Task Manager are ended.

2. Locate the Excel 15. x| b file in your AppDat a folder; the default location is:
C:\ User s\ user\ AppDat a\ Roani ng\ M cr osof t \ Excel

Tip:

You can quickly navigate to this folder by entering %@appdat a%
\' M crosoft\ Excel inthe address bar of Windows Explorer.

3. Right-click the Excel 15. x| b file name, then select Rename, then enter a new
name for the file, and then press Enter.

For example, append . ol d to the name:
Excel 15. x| b. ol d
4. Restart Excel.

A new Excel 15. x| b file is created in the C: \ User s\ user \ AppDat a\ Roani ng
\ M crosoft\Excel folder.

Extension Updates and Outlook

ORACLE

When applying extension updates, if any Office application is running, including
Outlook, a message directs the user to close all Office applications. This includes
Outlook, as well as Excel, Word, and PowerPoint.

If the message in Figure 1 is displayed after attempting an extension update, it means
that one of the Office applications was not closed. Often, the application left open is
Outlook.
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Figure 6-1 Message - Office Application Open During Extension Update

Oracle Smart View for Office >

An extension that is flagged for removal is currently in use in folder:
e CUsers' I AppDatat Reamingh Oracleh SmartView', Exte

nsions\BintOracle.SmartView. EPRCSExtension

Check if folder is open and close ALL Office Applications to release files,

Then recpen Office Application to allow Smart View to run removals

and updates,

Mote that this may affect additional updates during this session.

Exception: Access to the path 'EPRCSProvider.dll' is denied.

0K

If Smart View is not needed for Outlook, it can be disabled to help avoid this issue
during extension updates.

To disable Oracle Smart View for Office in Outlook:

1. In Outlook, go to the Smart View ribbon, then select Options, and then select
Advanced.

2. Under Display, select the Disable Smart View in Outlook check box.
3. Click OK, and then close Outlook.
4. Restart Outlook.

Verify that the Smart View ribbon no longer appears.

5. Start a different Office application to continue the extension update process.

Enabling the Smart View Extension for Firefox

ORACLE

During installation, Oracle Smart View for Office automatically installs an extension for
Mozilla Firefox.

If you specify Firefox as your default browser, Smart View utilizes the extension for
Firefox in these scenarios:

e Performing drill-through in Smart View

* Launching forms in Smart View from browser-based applications, such as
Planning or Oracle Hyperion Financial Management.

The extension for Firefox is automatically enabled after installing Smart View.
However, if the extension should become disabled, follow the procedure in this topic to
enable it again.

To enable the Smart View extension for Firefox:

1. In Firefox, in the upper right corner of the browser, click = , and then select
Add-ons from the drop-down menu:
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&

Add-ons

In the left pane, select Extensions, and then scan or search the list to locate the
Oracle Smart View Office entry.

Enz

Click Enable, and restart Firefox.

You can restart Firefox immediately using the Restart now link, or restart Firefox
at your convenience.

v Oracle Smart View Office will be enabled after you Restart now Undo
Oracle Smart View for Office (disabled)

Launch MS Office applications with Oracle Smart View content. More

Disable

Uninstallation Process Stops Responding

On supported Windows platforms, the Oracle Smart View for Office uninstallation
process may stop responding.

If you have experienced this issue, try the following:

1.

In the Windows Task Manager, kill all occurrences of these processes:
* Microsoft Register Server
*  Windows Installer

In the Control Panel, check Programs and Features to verify if Oracle Smart
View for Office is listed.

If Oracle Smart View for Office is not listed, then the uninstallation completed
successfully.

If Oracle Smart View for Office is listed, select it, and then select Uninstall to try
the uninstallation again.

Excel Looks for HsTbar.xml File After Uninstall

Sometimes, after uninstalling Oracle Smart View for Office and subsequently
launching Excel, Excel may still try to locate the Smart View HsThar . x! a file.

To correct this, you must edit the Windows Registry.

ORACLE
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To edit the Windows Registry to keep Excel from looking for HsTbar. xm file after
uninstalling Smart View:

1. Open the Windows Registry Editor (enter regedit in a command window).

2. Locate this key:

HKEY_CURRENT_USER\ Sof t war e\ M crosof t\ O f i ce\ <O f i ceVer si on>\ Excel \ Opti ons

3. Delete the OPEN or OPEN<n> entry where the value in the Data column contains

HsThar . xI a.

For example:

C:\Oracl e\ Smart Vi ew bi n\ HsThar . x| a

When there are multiple OPEN entries, perform these steps:

a. Delete all OPEN entries where the Data column value contains HsTbar . x| a.

b. Rename all remaining CPEN<n> entries, maintaining their sequential values.

For example, here are six OPEN entries, where two of the entries, OPEN and

OPEN4, contain HsThar . x| a in the Data column.

Narre

OPEN

OPENL
OPEN2
OPEN3
OPEMA
COPEN5

Val ue in
Cont ai ns
Does not
Does not
Does not
Cont ai ns
Does not

Data Col um
HsThar . x| a

contain HsThar.
contain HsThar.
contain HsThar.

HsThar . x| a

contain HsThar.

xla
xla
xla

xl a

Delete the OPEN and OPEM4 entries, and then rename the remaining entries as

follows, maintaining their sequential order:

¢ Rename OPENL to OPEN

¢ Rename OPEN2 to OPENL

¢ Rename OPEN3 to OPEN2

¢ Rename OPEN5 to OPEN3

The remaining entries are:

Nane
CPEN
CPENL
CPEN2
CPEN3

Value in
Does not
Does not
Does not
Does not

Data Col um

contain HsThar.
contain HsThar.
contain HsThar.
contain HsThar.

xla
xla
xla
xla

Internet Explorer Compatibility View Settings for Financial

Reporting

ORACLE

When running a Oracle Hyperion Financial Reporting report from Oracle Smart View
for Office, a web control is called that causes this error to display: "The product does
not support compatibility view. Contact your system administrator to help configure

your settings."

By default, the web control runs in compatibility mode, triggering the compatibility

message.
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Workarounds:

» Click to clear the message, and the report preview displays as expected.
* To avoid the compatibility message, modify the Windows Registry as follows.
For 32-bit Office:

In [ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Wow6432Node\ M crosof t\ I nt ernet Expl orer\ MAIN
\ Feat ur eCont r ol \ FEATURE_BROASER EMULATI ON] , add the following three DWORD (32-
bit) values:

" EXCEL. EXE" =dwor d: 00008000
" POAERPNT. EXE" =dwor d: 00008000
" W NWORD. EXE" =dwor d: 00008000

For 64-bit Office:

Add the three DWORD values for Excel, PowerPoint, and Word in
[ HKEY_LOCAL_MACH NE\ SOFTWARE\ M crosoft\ I nternet Expl orer\ MAI N\ Feat ur eCont r ol
\ FEATURE_BROWSER EMULATI OV .

The values must match your installed version of Internet Explorer. If you are
unsure which entry to use, then use the 32-bit Office values noted above.

Internet Explorer 8:

" EXCEL. EXE" =dwor d: 00008000
" POAERPNT. EXE" =dwor d: 00008000
" W NWORD. EXE" =dwor d: 00008000

Internet Explorer 9:

" EXCEL. EXE" =dwor d: 00009000
" POAERPNT. EXE" =dwor d: 00009000
" W NWORD. EXE" =dwor d: 00009000

Internet Explorer 10:

" EXCEL. EXE" =dwor d: 00010000
" POAERPNT. EXE" =dwor d: 00010000
" W NWORD. EXE" =dwor d: 00010000

Internet Explorer 11:

" EXCEL. EXE" =dwor d: 00011000
" POAERPNT. EXE" =dwor d: 00011000
" W NWORD. EXE" =dwor d: 00011000

Web Launch with Internet Explorer in Protected Mode

ORACLE

When Microsoft Internet Explorer is running in protected mode, web launch does not
function. This means you cannot launch Oracle Smart View for Office content from
Internet Explorer.

In Internet Explorer, you can add specific website URLS as trusted sites and clear the
protected mode setting for those sites. Then you can launch Smart View content from
Internet Explorer

To add trusted URLs and clear the protected mode setting for those URLSs:

6-18



Chapter 6
Working with Custom HTML-based Login Forms

1. In Internet Explorer, go to Internet Options, then Security, and then Trusted
sites.

2. Click Sites, then add the workspace URL or cloud service URL to the list of trusted
sites.

Repeat for all trusted workspace and cloud service URLs that you want to add.
3. Click Close.
4. Verify that in the Security tab, the Enable Protected Mode check box is cleared.

5. Click OK to exit the Internet Options dialog, and restart Internet Explorer.

Working with Custom HTML-based Login Forms

If you are using a custom HTML-based login form instead of the default Oracle Access
Manager login form, ensure that the source of the custom form includes the string

I ogi nf orm This is required for Oracle Smart View for Office integration with Oracle
Access Manager to work.

Browser Settings When Working with XML Files on HTTP

Server

ORACLE

Internet Explorer may cache XML files posted on an HTTP server and referenced by
Oracle Smart View for Office. This can cause problems when using the following
Smart View functionality:

» Accessing shared connections from an XML file

This is the XML file posted on an HTTP server and noted in the Shared
Connections URL field of the Smart View Options dialog box. If you plan to
access online help from a local drive or internal web server, this file can also
specify the location of the help.

* Updating extensions

Smart View references the Updat eLi st. xni file that is posted on an HTTP server
when Smart View end users install, update, and remove extensions in the
Extensions tab of the Options dialog box.

Complete the steps in this topic to clear the browser cache so that the latest version of
the XML file is used for the purposes noted above.

To clear the cache so that Smart View is accessing the latest XML file version posted
on an HTTP server, set the following options in Internet Explorer:

1. Select Tools, then Internet Options.
2. Inthe General tab, Browsing history group, select Settings.

3. Inthe Check for newer versions of stored pages section, select Every time |
visit the webpage, and then click OK.

4. In the Internet Options dialog box, select the Advanced tab.

5. In the Security section, select the Empty Temporary Internet Files folder when
browser is closed option.

6. Click OK to close Internet Options and restart the browser.
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Flickering Issues on Office 2013 and Office 2016

When using Smart View with Microsoft Office 2013 or 2016, 32-bit or 64-bit, flickering
occurs with the POV toolbar and the Smart View Panel. The flickering is likely caused
by changes in Excel 2013 and Excel 2016.

To reduce flickering, Oracle advises that you add the following two DWORD values to
the Windows Registry:

e Disable Window Transitions (DisableWindowTransitionsOnAddinTaskPanes)

e Disable Office Animations (DisableAnimations)

Disable Window Transitions
(DisableWindowTransitionsOnAddinTaskPanes)

ORACLE

To improve the user experience, you may enable the DWORD value
DisableWindowTransitionsOnAddinTaskPanes for Office 2013 and 2016. To do this,
add the DisableWindowTransitionsOnAddinTaskPanes key value to the Toolbars key
in the Windows Registry as follows:

* Key Name:

[ HKEY_CURRENT _USER\ Sof t war e\ M crosof t\ Of fi ce\ <O fi ceVer si on>\ Conmon\ Tool bar s]
*  New DWORD and value:

"Di sabl eW ndowTr ansi t i onsOnAddi nTaskPanes" =dwor d: 1

To add the new DisableWindowTransitionsOnAddinTaskPanes DWORD to the
Toolbars registry key:

1. Click Start, click Run, type regedi t in the Open box, and then click OK.

2. Depending on your Office version, locate and then select the following registry
key:

*  Office 2013:
HKEY_CURRENT_USER\ Sof t war e\ M crosof t\ O fi ce\ 15. 0\ Conmon\ Tool bar s
*  Office 2016:
HKEY_CURRENT_USER\ Sof t war e\ M crosof t\ O fi ce\ 16. 0\ Conmon\ Tool bar s
3. From the Edit menu, select New, and then select DWORD Value.
4. Type Di sabl eW ndowTr ansi ti onsOnAddi nTaskPanes, and then press Enter.

5. In the Details pane, right-click DisableWindowTransitionsOnAddinTaskPanes,
and then select Modify.

6. Inthe Value data box, type 1, and then click OK.
7. Exit Registry Editor.

8. Restart Excel.
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Disable Office Animations (DisableAnimations)

To further improve the user experience, you may disable Office Animations for Office
2013 and 2016 by adding a key and DWORD value to the Windows Registry. To do
this, create the Graphics key and DisableAnimations key value as follows:

* Key Name:

[ HKEY_CURRENT_USER\ Sof t war e\ M crosof t\ Of fi ce\ <Of fi ceVer si on>\ Conmmon\ G aphi cs]
* Key Value:

"Di sabl eAni mat i ons" =dwor d: 00000001

To create and then update the registry key, G aphi cs, and add the new
DisableAnimations DWORD value:

1. Click Start, click Run, type regedit in the Open box, and then click OK.
2. Locate and then select the following registry key:
»  Office 2013:
HKEY_CURRENT _USER\ Sof t war e\ M crosof t\ O fi ce\ 15. 0\ Conmon\
»  Office 2016:
HKEY_CURRENT_USER\ Sof t war e\ M crosoft\ Of fi ce\ 16. 0\ Conmon\
From the Edit menu, select New, and then select Key.
Type G aphi cs, and then press Enter.

From the Edit menu, select New, and then select DWORD Value.

3
4
5
6. Type Disabl eAni mati ons, and then press Enter.
7. Inthe Details pane, right-click DisableAnimations, and then click Modify.
8. In the Value data box, type 00000001, and then click OK.

9. Exit Registry Editor.

10. Restart Excel.

Transition Navigation Keys Not Supported

ORACLE

Oracle Smart View for Office does not support Excel's Transition navigation keys
option.

Due to a Microsoft limitation, many of the Microsoft APIs that Smart View depends on
for both Smart View and Excel functionality do not work when the Transition
navigation keys option is enabled. For example:

e In Excel, copy/paste, macros, automation API calls do not work correctly.

e Inthe Planning Admin extension, member formula formatting in the Smart View
Dimension Editor does not display correctly; formulas have incorrect syntax when
submitted to Oracle Hyperion Planning.

In order to ensure the best performance possible, Smart View requires the following:

*  The Excel option, Transition navigation keys, must be cleared.
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The Smart View option, Improve Metadata Storage, must be enabled (by
default, this option is enabled).

Smart View HTTP Session Timeout

HTTP session timeouts can occur, for example, when working with large queries that
take a long time to run, or when you're experiencing slower internet connections.

ORACLE

To avoid HTTP session timeouts, you may add the following Windows Registry
DWORDS to the Internet Settings key:

Key Name:
HKEY_CURRENT_USER\ Sof t war e\ M cr osof t \ W ndows\ Current Ver si on\ I nt ernet Settings
Key Values:
— DWORD: ReceiveTimeout
Value data: value in milliseconds
— DWORD: KeepAliveTimeout
Value data: value in milliseconds
— DWORD: ServerinfoTimeout
Value data: value in milliseconds

For example, 900000 milliseconds is the equivalent of 15 minutes. Adjust the
timing according to your requirements.

As a guideline, 900000 milliseconds is the equivalent of 15 minutes.

To add the timeout key values to the Internet Settings registry key:

1.
2.
3.

Ensure that all Office applications, including Outlook, are closed.

Launch the Windows Registry Editor.

Locate and then select the following registry subkey:

HKEY_CURRENT _USER\ Sof t war e\ M cr osof t \ W ndows\ Current Ver si on\ I nternet Settings

Add the three DWORD key values, Recei veTi meout , KeepAl i veTi meout , and
Server | nfoTi neout :

a. From the Edit menu, select New, and then select DWORD Value.
b. Type the DWORD name, and then press Enter.

c. Inthe Details pane, right-click DWORD you added in step 4.b, and then select
Modify.

d. Inthe Value data text box, type the timeout value in milliseconds, select
Decimal, and then click OK.

e. Repeat step 4.a through step 4.d for each of the three required DWORD key
values.

Exit Registry Editor.

Restart Excel.
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Duplicate Queries in Word Slow to Refresh

In some Word documents containing a large number of queries and created prior to
Oracle Smart View for Office release 11.1.2.5.520, performance may be an issue
when refreshing the data in the document. In some cases, instead of re-using existing
gueries where appropriate, each Smart View data point in the Word document is
treated as a separate query. The result is that Refresh operations can be very slow.

If the document contains many duplicate queries (that is, queries with the same
name), the duplicate queries are displayed in the Document Contents pane in Word.
For example, Document Contents might look like this:
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Smart Yiew v )
Document Contents & ~-¥ »
[ Smart Yiew - Current Documment I vl -+ -

o SmartViewl14446361770 ."..I

oral® SmartView 14446361770
2¥ SmartView14446361770
4% SmartView14446361770
oalW SmartView14446361770
A% SmartView14446361770
¥ Smartiiew! 4446361770
----- A SmartViewl4446361770
¥ SmartView14446361770
o ® SmartView14446361770
Y SmartViewl 4446361770
m¥ SmartView14446361770
o Omartiewl 4446361770
A SmartView14446361770
o SMnartiiew 14446361770
- a¥ SmartView14446361770
¥ SmartView14446361770
. ﬂl“ SmartView 14446361770
- 4® SmartView14446361770
¥ Smartiiew! 4446361770
ol Smartyiew 14446361770
¥ SmartView14446361770
- 4 Function Grid

m? SmartViewl 4446541490
m¥ SmartView]1 4446541490
P Omartiewl 4446541490
A SmartView14446541490
o SMnartiiewl 4446541490
¥ Smartyiew14446541490
i ﬂv SmartView 14446541490
ol SmartView14446541490
- Af® SmartView14446541490
¥ Smartiiew! 4446541490
al® SmartView14446541490
¥ SmartView14446541490
o SmartView14446541490
Al SmartView14446541490 -|

The duplicate queries are Smart Vi ewl4446361770 and Smart Vi ewl4446541490.

You can run the Visual Basic macro below to remove the duplicate queries:

Sub Del et eExt raQueries()

' Del eteExtraQueries Macro

Di m queriesName As Vari ant

Di m uni queQueri esNane As New Col | ection
Di m var Name, newlist As String

Set vars = ActiveDocunent. Vari abl es

ORACLE"
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For i =1 To vars. Count
varNane = vars.lten(i). Nane
[f Not StrConp(vars.lten(i).Nane, "SV_QUERY_LIST", vbTextConpare) Then
List = vars.Iten(i). Val ue
queri esNanme = Split(List, "<|>")

On Error Resume Next
For Each queryNanme |n queriesNane
uni queQueri esNane. Add queryNane, queryName
Next
newList = ""
For Each queryNane In uni queQueriesName
newLi st = newLi st & queryNane & "<|>"
Next
newLi st = Left(newlist, Len(newList) - 3)
vars.ltenm(i).Val ue = newli st
End | f

Next
End Sub

After running the macro, the two queries, Smart Vi ewl4446361770 and
Smart Vi ewl4446541490, appear only once in Document Contents:

Smiarkt Yiew v X
Document Contents & -v »
| Smart Yiew - Current Document |-*| 2> =

030_Financial_instruments_-_B - corrected.d
=l ¥ SmartView14446361770
Fal Function Grid

=] a® Smartview 14446541490
Fa Function Grid

Issues with Dynamic Data Exchange Option in Excel

ORACLE

Various issues may arise when the Excel option, Ignore other applications that use
Dynamic Data Exchange (DDE), is selected. For example, there are problems
launching Excel, launching Excel files from outside of Excel, and using the Export in
Query Ready Mode option from a browser to export balances from Oracle Hyperion
Financial Reporting.

Workaround: Click the Microsoft Office Button (upper left corner of Excel), and then
click Excel Options. In the Advanced category, scroll down to the General options,
and then clear the Ignore other applications that use Dynamic Data Exchance
(DDE) check box. Restart Excel.
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Performance and Memory Usage Considerations for Smart
View with Excel

ORACLE

Oracle Smart View for Office is a Microsoft Office add-in. As an add-in, it is loaded in
to the Microsoft Excel process. When a report is imported into Excel through Smart
View, the Excel process consumes memory and this can negatively impact
performance.

For example, instances of grids and forms, objects in the Undo buffer, XML parsing,
etc., will cause the Excel process to consume memory. Because of this, the Excel or
machine memory limit becomes the Smart View memory limit as well. This can
severely impact performance.

There is no memory configuration parameter in Smart View to manage this.
Excel 32-bit and 64-bit have different memory limits:

*  For Excel 32-bit, the maximum memory limit, or RAM, is 2GB.

Oracle testing showed that when Excel 32-bit memory usage reaches beyond 700
MB, Excel can behave abnormally and can terminate unexpectedly.

*  The 64-bit versions of Excel are not constrained to 2 GB of RAM, as are the 32-bit
Office applications.

For large reports, Oracle recommends using 64-bit Excel. Or consider reducing
the data being sent to Smart View by reducing the number of rows, columns, and
POVs in the reports.

Oracle suggests that you consider taking some or all of the actions listed below in an
effort to limit memory usage and improve performance.

The following actions can help to limit memory usage:

1. Inthe Smart View Options dialog box, Advanced tab, ensure that these options
are enabled:

* Reduce Excel File Size
* Improve Metadata Options

2. In the Options dialog box, Advanced tab, set Number of Undo Actions to '0'
(zero), if possible, or to a low number such as 1 or 2.

3. Change Excel calculation from Automatic to Manual. Go to the Excel Formulas
ribbon, then select Calculation Options, and then select Manual.

4. In the Options dialog box, Formatting tab,

a. If you have selected the Use Excel Formatting option, then you should clear
the Move Formatting on Operations option.

b. Clear the Adjust Column Width option.
c. Clear the Retain Numeric Formatting option.
5. In the Options dialog box, Extensions tab, disable any unneeded extensions.

6. In Excel, to improve performance and stability, disable or uninstall any unused
add-ins. For example, disable or uninstall the Oracle Essbase Spreadsheet Add-
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in. Other possible add-ins to disable or uninstall are, for example, Adobe PDF,
WebEX, or Send to Bluetooth

7. Reduce the workbook size.
8. Limit the data imported to Excel:

a. Use prompts, filters, POVs, or other ways to reduce the data returned back to
Smart View.

b. Enable the Suppress Rows and Suppress Columns options in the Data
Options tab of the Smart View Options dialog box.

The following actions can help to improve performance, as well as limit memory
usage:

1. In the Options dialog box, Advanced tab, set Number of Undo Actions to '0'
(zero), if possible.

2. In the Options dialog box, Member Options tab, ensure that these options are
cleared:

* Preserve Formulas and Comments in ad hoc options
*  FormulaFill

Clear these options only if you do not need to preserve formulas or comments
during ad hoc operations.

Also, refer to the following documentation from Microsoft, "Excel 2010 Performance:
Performance and Limit Improvements":

http://msdn.microsoft.com/en-us/library/ff700514(v=office.14).aspx

Unbalanced Loads in Provider Services Clustered
Environments

Two-Way

ORACLE

In some Oracle Hyperion Provider Services clustered environments, if Oracle Smart
View for Office requests appear to be going to only one server in the cluster (that is,
the load is unbalanced), then try changing the security level in Microsoft Internet
Explorer to Medium.

To do this, in Internet Explorer, go to Tools, then Internet Options, and then select
the Security tab. Under Security levels for this zone, set the allowed level for the
affected zone to Medium.

SSL and Problematic Certificates

If two-way SSL is set up with problematic certificates between Oracle Smart View for
Office and other Oracle Enterprise Performance Management System data providers,
Smart View will prompt for the client-side certificate with every request. For example,
the user will be prompted when connecting to the data source, connecting to an
application, connecting to a database, and at every refresh, submit, or zoom operation.

To avoid this situation, you must update the properties. xnl file on each end user
machine to add the client Cert name tag. For example:

<cfg>
<provi der >
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<url >http://server:port/workspace/ Smart Vi ewProvi ders</url >

</ provi der>

<hel purl cont ext ></ hel pur| cont ext >

<extensi onupdat el i st>http://server: port/extensionupdatelist/UpdateList.xm |
9GVCLI ENTI NSTALLPATHY ext ensi ons/ Updat eLi st . xm </ ext ensi onupdat el i st >

<I-- Require Smart View to pronpt the user for the client-side certificate -->

<clientCert name="PROWPT- ONLY"/>
</cfg>
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